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1.0 INTRODUCTION 

Thousands of facilities nationwide handle, manufacture, use, or store toxic and flammable 
substances in quantities above Environmental Protection Agency (EPA)-regulated thresholds. 
Each of these facilities is required by law to implement a risk management program that details 
the toxics and flammables it has on-site, its accident history, prevention program, and emergency 
response program.  Every five years, or sooner if changes occur, each of these facilities must 
submit to EPA a summary of this information, known as a Risk Management Plan (RMP). 
Given the number of regulated facilities, a vast amount of RMP data is generated. 

The Systems for Risk Management Plans (SRMP) Program was established by EPA to manage 
the submission, processing, and storing of the data, as well as provide for the secure 
dissemination of the data to the EPA regions; local, state, and federal officials; and the public. 

The RMP*Review System is a major component of the SRMP program by which users can easily 
and efficiently review, analyze, and query the enormous amount of facility data contained in the 
thousands of RMPs submitted to EPA. 

The Chemical Safety Information, Site Security and Fuels Regulatory Relief Act (Public Law 106
40) (and regulations) was enacted to address concerns that Internet posting of a large database 
created from the OCA sections of RMPs would pose law enforcement and national security risks. 
Federal, state, and local “covered persons” may obtain access to this information for official use 
only.   Users are prohibited from publicly releasing OCA information, except as authorized by the 
law and regulations issued under CSISSFRRA.  Appendix E–Security Notice to Federal, State and 
Local Officials–contains complete information concerning security of OCA information for these 
covered persons. RMP data with the OCA portion removed is available for non-covered persons. 
(See Appendix E – United States Environmental Protection Agency Security Notice to Federal, 
State and Local Officials.) 

1.1 RMP*Review System Overview 

The RMP*Review System consists of two Microsoft (MS) Access 97 run-time applications — 
RMP*ReviewAdmin and RMP*Review. RMP*ReviewAdmin is used only by the RMP*Review 
System Database Administrator (DBA), whereas RMP*Review is for all users. At a single-user 
site, the user is also the DBA. 

RMP*ReviewAdmin is used to: 

C Import RMP data into the RMP*Review System database. 

C Manage and maintain audit lookup tables.  Audit lookup tables contain descriptions of 
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audit/inspection personnel, audit status, and audit types that the users need when creating 
audit records for facilities. 

C	 Add, modify, or delete user-defined field names to which RMP*Review users may assign 
data values prior to running queries. 

C	 Define criteria that will allow users to rank and score facilities based on those criteria. 

RMP*Review is used to: 

C	 Display RMPs and review them. 

C	 Display tracking system information for RMPs that could not be processed by EPA. 

C	 Define simple or complex query statements, and run them against stored RMPs. 

C	 Enter facility audit information. 

C	 Choose RMP ranking and scoring data (as a function of criteria defined by the DBA via 
the RMP*ReviewAdmin application). 

C	 Modify, query, and apply user-defined data. 

C	 Generate reports and mailing labels. 

C	 Export query results and other RMP data to foreign formats, such as a Lotus spreadsheet 
or Hypertext Markup Language (HTML) for Web use. 

1.2	 RMP*Review System Requirements 

The RMP*Review System software is supplied on a compact disk (CD) and installed by the DBA. 
To install and run RMP*Review, you need a minimum of 16 MB of Random Access Memory 
(RAM) (32 MB of RAM is recommended) and the following disk space requirements for the 
separate components of the RMP*Review System: 
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Installation Disk Space Required for Individual Components of RMP*Review System 

Application Name Space for 
Application 

Space for Setup 
Directory 

Space for MS Access 
Run-Time Version 

RMP*ReviewAdmin  3,200 KB1 1,700 KB 4,566 KB2 

RMP*Review 3,500 KB 1,700 KB 4,566 KB2 

RMP*Review Data 
(empty—i.e., template minus 
state dbase files and graphics 
files) 

1,100 KB 1,700 KB N/A 

1Kilobytes 
2Unless already installed. 

NOTE: Refer to Appendix C for a listing of estimated disk space requirements for individual 
state dBase files.  Plan for 50% growth in RMP*Review data storage requirements as additional 
RMPs are collected and added to the database. 

Listed below are the minimum computer hardware and software requirements for installing and 
running RMP*Review. 

Hardware: 

Personal Computer (PC): IBM-compatible with a 486 DX2 or higher central processing unit 
(CPU); Pentium or higher is recommended. 

Monitor: Super Video Graphics Adapter (SVGA) (600 x 800 pixels) is the 
minimum requirement. 

Printer: Hewlett-Packard (HP) LaserJet or compatible printer is 
recommended. 

Mouse: MS-compatible mouse or other compatible pointing device is 
required. 

Software: 

Operating Environment: Windows 95 or Windows 98 (Windows NT capability may be 
supported in the future). 

1.3 RMP*Review System Roles and Responsibilities 
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Two distinct personnel functions are identified in this User Manual: “DBA” and “user.”  The 
DBA is the technical person who installs all the software components of the RMP*Review System 
and is responsible for the RMP*ReviewAdmin functions listed in Section 1.1. The typical user is 
the on-site person who requires the functionality of the RMP*Review System to carry out the 
RMP*Review functions listed in Section 1.1. 

The RMP*Review System can be used in both single-user and multi-user environments.  At a 
single-user site where the DBA is also the user, all the software is installed on the DBA’s PC.  In 
a multi-user environment, the DBA installs the RMP*ReviewAdmin software on his/her own PC; 
installs the RMP*Review Data folder on a local area network (LAN), making it accessible to all 
users; and installs the RMP*Review software on each user’s PC. 

1.4 Organization of This Manual 

This RMP*Review User Manual comprises the following sections: 

Section 1.0 Introduction: A brief introduction to the RMP*Review System and this User Manual. 

Section 2.0 - Functionality of RMP*Review System: An overview of how the RMP*Review 
System operates and how its components interrelate. 

Section 3.0 - RMP*Review System Installation Procedures: Procedural steps for installation of 
the RMP*Review System.  These functions are the responsibility of the RMP*Review System 
DBA. 

Section 4.0 - Loading RMP Data: Procedural steps to download states RMP data from the Web. 

Section 5.0 - RMP*ReviewAdmin: Procedural steps for all functions of RMP*ReviewAdmin. 
These functions are the responsibility of the RMP*Review System DBA. 

Section 6.0 - RMP*Review: Procedural steps for all functions of RMP*Review. These functions 
are the responsibility of the typical user. 

1-4




1.5 Document Conventions 

The conventions used in this manual are as follows:


C Computer commands are bolded (e.g., select Print).


C Titles as they appear on RMP*Review System screens and screen elements (tabs, column

headings, button names, etc.) are bolded. 

C Keystrokes to be entered are bolded and enclosed within less than (<) and greater than (>) 
symbols (e.g., press <F1>). 

C Two keystrokes joined by a plus sign (+) indicates that the two keys should be pressed 
simultaneously (e.g., <Alt+C>). 

C Multiple selections in left to right sequence are indicated by a greater than (>). 

1.6 Help Resources 

Help is always available from any screen in the RMP*Review System.  Click Help > Contents 
and Index > Index at the menu bar. This will bring you to an automated index with hundreds of 
keywords and extensive cross-referencing.  Follow the directions in the dialog box to search for 
the information you need. 

Press <F1>to get context-sensitive help for an on-screen field at which your cursor is located. 

Normally the Help window disappears when you click outside it.  However, you can choose 
Always on Top as the default from the Help window Options menu to keep the Help window in 
view while you work.  Choose Always on Top again to turn the option off. 
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2.0 FUNCTIONALITY OF THE RMP*REVIEW SYSTEM 

The RMP*Review System includes the following two MS Access 97 run-time applications (with

filename and extension):


C RMP*ReviewAdmin (RMPReviewAdmin.mde).

C RMP*Review (RMPReview.mde).


The functions provided by RMP*ReviewAdmin and RMP*Review are described in Section 2.1

and 2.2, respectively.  The RMP*Review System requires the following five MS Access databases

(with filename and extension): 


C Facility (RMPFac.mdb). 

C RMP (RMPData.mdb). 

C Audit (RMPAudit.mdb). 

C User-Defined Fields (RMPUser.mdb).

C Rank and Scoring (RMPRS.mdb).


These five databases are installed in a common folder during RMP*Review Data installation (see

Section 3.3). The common folder resides on a LAN in a multi-user environment or on a PC in a

single-user environment.  In either case, these databases must always reside in the same folder. 

The databases include OCA data for “covered persons” under Public Law 106-40.  Access to this

material is limited by this law (see Appendix E). 


The RMP*Review System also includes several programs to repair and compact specific database

files. Repair and compaction of database files is discussed in Section 2.3.


2.1 RMP*ReviewAdmin Application 

The RMP*ReviewAdmin application provides the administrative functions of the RMP*Review 
System that are handled by the DBA.  The following functions are accessible through the 
application’s main menu: 

C Import.

C Audit Lookup Tables.

C User-Defined Fields.

C Rank and Scoring.
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2.1.1	 Import RMP Data 

The Import function provides the following capabilities: 

•	 Locate the folder containing the compressed RMP state data files. 

•	 Convert the RMP state data files (i.e., expand and import the expanded data into an 
intermediate MS Access database). 

•	 Replace the shared RMP database with the intermediate database. 

2.1.1.1 Locate RMP Data 

RMP*Review will load RMP data either with or without OCA data. RMP state data files – 
without OCA data – will be available for download from the Web.  For covered persons, RMP 
state data files - with OCA - will be distributed on CD-ROM through the US mail.  The DBA will 
use the ‘locate’ function to point to these files, whether they be on CD or files downloaded from 
the Web.  Downloading of state RMP data is discussed in Section 4.0. 

2.1.1.2 	Convert Downloaded RMP Data 

The ‘convert’ function expands the compressed state dBase RMP data files and converts them 
into an MS Access database. 

2.1.1.3 	Replace the RMP Database 

The ‘replace’ function completely replaces the shared RMP database and updates the Facility 
database but does not overwrite or reload the Audit, Rank and Scoring, and User-Defined 
databases. The updated MS Access database and associated graphics files are copied to the RMP 
database location during the Replace.  In a multi-user configuration, the five database files will be 
located on a LAN. 

2.1.2	 Audit Lookup Tables 

Using the Audit Lookup Tables function, the DBA can directly add, delete, and modify the values 
and descriptions stored in the RMP*Review Audit Lookup Tables.  The DBA must have exclusive 
use of the database (i.e., no other users on it) before the tables can be updated. 

2.1.3	 User-Defined Fields 

With the User-Defined Fields function, the DBA is able to create custom labels for 13 definable 
fields.  One or more user fields are provided for each of the following data types: check box, date, 
text, number, and memo.  The DBA requires exclusive use of the User-Defined database file to 
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perform this function. 

2.1.4 RMP Rank and Scoring 

With the Rank and Scoring function, the DBA is able to define and customize criteria in 
RMP*Review Admin for ranking RMPs.  The Rank and Scoring definitions are saved in a 
separate database (RMPRS.mdb) and can be modified by the DBA at a later time.  Users may then 
select from these definitions in RMP*Review to display ranking and scoring data for the facilities. 
See Appendix D for a Scoring and Ranking example. 

2.2 RMP*Review Application 

The RMP*Review application provides EPA Headquarters (HQ) and Regions, States and local 
governments with the ability to evaluate and analyze RMPs.  RMP*Review functions are accessed 
through the application’s Main Menu where the user finds the following options: 

C Facility List. 
C Attach Database. 
C RMP Tracking System. 
C Advanced Query by Example (QBE). 
C Choose Ranking. 

2.2.1 Facility List 

The Facility List function allows the user to search for RMPs by name and location, display 
ranking data as aggregate scores or numerical (ordinal) ranking values, create queries, choose to 
view either the most current RMPs or all RMPs, generate reports, print mailing labels, display 
online help, and print the Facility List.  The List of Facilities Screen displays the EPA-assigned 
Facility ID, facility name, the number of RMPs submitted, and either ordinal rank or aggregate 
score for each listed facility.  In addition, the user can change the sort order or display format of 
the listed facilities. 
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2.2.1.1 RMP Facility Search 

From the List of Facilities Screen, the user can search the facility list by facility name and 
location. 

2.2.1.2 View RMPs 

Users can choose among several options to view RMPs.  You can view all RMPs submitted by a 
facility or only the most current RMPs.  One section of an RMP can be viewed by itself, or two or 
more sections can be viewed simultaneously using Windows’ tile and cascade options.  RMPs can 
be viewed in Form View or Data Sheet View. Form View is the default view that displays the 
RMP sections as submitted.  Data Sheet View, selectable from an RMP detail screen, displays 
RMPs in rows and columns like a spreadsheet.  The Data Sheet View can be customized, and 
columns may be reordered and resized. 

2.2.1.3 Audit 

The Audit function lets users enter facility audit date, audit type, audit status, personnel assigned 
to audit, and audit comments. Audit types, statuses, and personnel are established by the 
RMP*Review System DBA using RMP*ReviewAdmin and are accessible via pick-list buttons 
(ó) in RMP*Review. 

2.2.1.4 User-Defined Fields 

Users can view and update data in user-defined fields associated with facilities. User-Defined 
labels are defined by the RMP*Review System DBA using RMP*ReviewAdmin. One or more 
definable fields are provided for each of the following data types: check box, date, text, number, 
and memo. 

2.2.1.5 Reports 

With the RMP*Review application, the user can generate the following five standard reports: 

C RMP Detail: Contains only those sections of an RMP chosen by the user.

C RMP Audit Data: Contains an audit report for a selected facility.

C RMP User Data: Contains a user-defined report for a selected facility.

C RMP Facility List: Contains all the fields displayed on the Facility List Screen.

C RMP Audit List: Lists audit data for a list of facilities.


The first three report types are for a selected facility.  The last two are for the list of facilities.  The

list of facilities may be the entire list or a filtered subset.
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2.2.2 Attach Database 

The Attach Database function provides the capability of retaining multiple RMP*Review Data 
folders.  Each such folder contains Facility, RMP, Audit, User-Defined, and Rank and Scoring 
database files.  The attachment function attaches to all five files in a selected RMP*Review Data 
folder. Database maintenance procedures and directory-naming conventions for the installation 
are the responsibility of the DBA. 

2.2.3 RMP Tracking System 

When a facility submits an RMP that is not able to be processed, it is logged by EPA’s Reporting 
Center into the RMP*Maintain Tracking System.  Any problems with the RMP (e.g., unreadable 
files on the diskette) are documented for tracking purposes.  RMP*Review users can view this 
tracking system information by selecting RMP Tracking System at the Main Menu. 

2.2.4 Query By Form (QBF) 

The QBF user interface looks like the RMP section being queried.  With this function, users can 
create simple queries by entering specific values and boolean operators within fields.  From any 
RMP section, the user can use the Query By Form (QBF) facility to narrow the number of RMPs 
being viewed by clicking the Query (QBF) button. As an example, to query the RMP database 
for RMPs from facilities in a particular state that use the process chemical “ammonia,” the user 
clicks Query (QBF) and enters the state’s two-character state in the State field (RMP Section 1.5) 
and <ammonia> in the process chemical field (Section 1.17). When the user executes the query, 
the RMPs displayed will fit the criteria entered by the user.  QBF is covered in depth in Section 
6.8. 

2.2.5 Advanced Query By Example (QBE) 

The Advanced QBE function allows the user to create and execute complex multi-table queries. 
The user may select tables, fields, joins, and sort orders for the QBE function to construct 
Structured Query Language (SQL).  The user can view and edit the SQL generated by this 
function. Operations are available to create, save, load, view, close, and execute queries. 
Advanced QBE is covered in depth in Section 6.9. 
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2.3	 Repair and Compaction of Database Files 

Database management systems use elaborate indexing schemes to quickly access specific records 
in a direct fashion rather than serially searching through a database.  As records are added and 
deleted inefficiencies develop in the indexing schemes and data storage, and the efficiency of 
record access is degraded.  Additionally, it is even possible for indexes to become damaged, such 
that you might not be able to access some of the database records and thus resulting in error 
messages from the database management system being used.  Fortunately, it is possible to rebuild 
record indexes and restore the database to an efficient operating state. 

The RMP*Review System includes several programs to repair and compact specific database files. 
The general user has access to one of these programs for database files which are stored on the 
user’s PC.  The DBA has access to the remainder of the repair and compact programs and has the 
responsibility of repairing and compacting database files affecting all users. 

Depending on your site’s installation, one or more PCs may need database files repaired and 
compacted.  If degraded conditions are being experience, the DBA can usually alleviate them by 
performing the following steps: 

1.	 Make sure that no users have the RMP*Review System in use. 

2.	 At the DBA’s PC, click Start at the bottom left of computer screen, then point to 
Programs for a list of installed programs.  Click on RMP ReviewAdmin, then in the pop
up menu click Repair and Compact RMP ReviewAdmin. 

3.	 At the database server, click Start, then click RMP Review Data, then click once on each 
of the Repair and Compact programs to execute them.  Wait for each to complete before 
starting the next. 

4.	 At the users’ PCs, click Start, then click RMP Review, then click Repair and Compact 
RMP Review. 

NOTE: If your site is a single-user site, then you would be both the DBA and the user, and the 
Repair and Compact programs would all reside on the same PC. 
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3.0	 RMP*REVIEW SYSTEM INSTALLATION PROCEDURES 

This section contains the procedures for installing the RMP*Review System consisting of 
RMP*ReviewAdmin, RMP*Review Data, and RMP*Review. The DBA has the responsibility for 
setting up common RMP data and definitions.  At a single-user site, the DBA installs 
RMP*Review, RMP*Review Data, and RMP*ReviewAdmin on his/her own PC.  At a multi-user 
site, the DBA installs RMP*ReviewAdmin on his/her own PC, RMP*Review Data on the site 
server, and RMP*Review on the PC of each respective user. 

IMPORTANT: If you had the RMP*Review Beta Test installed on your computer, you must 
delete it before you install the production RMP*Review system. 

Instructions for removing old (Beta test) version of RMP*Review: 
Click the Start Button, choose "Settings", then choose "Control Panel".  Then choose 
"Add/Remove Programs".  Find RMP*Review on the list of programs, and press the 
"Add/Remove" button, then the "Remove All" button.  Do this also for RMP*Review Admin and 
RMP*Review Data. If you are prompted to restart the computer, you do not have to restart until 
you have finished removing all three programs. 

NOTE: At install completion of any of the three components of the RMP*Review System, you 
may receive a screen message telling you to restart Windows.  If you receive this message, you 
need only restart Windows once after you have finished installing the last of the components to be 
installed on the subject PC. 

3.1	 RMP*ReviewAdmin Installation 

The DBA installs RMP*ReviewAdmin on his/her own PC as follows: 

1.	 Insert the installation CD into the CD-ROM drive. 

2.	 Open Windows Explorer (accessible by clicking Start at the bottom left corner of the 
screen). 

3.	 Click on [CD-ROM drive]:\Review Admin and double-click setup.exe. 

4.	 At the RMP*ReviewAdmin Setup Installation Welcome Screen (Exhibit 3-1), click 
Continue to go on with the install or click Exit Setup to end the install. 
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Exhibit 3-1.  RMP*ReviewAdmin Setup Installation Welcome Screen 

5.	 At the RMP*ReviewAdmin Destination Folder Screen (Exhibit 3-2), click OK to install 
the application in the default folder specified on the screen, or click Change Folder to 
install the application in a folder of your choosing. 

Exhibit 3-2.  RMP*ReviewAdmin Destination Folder Screen 
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If you click Change Folder, choose the destination folder filepath at the Change Folder 
Screen (Exhibit 3-3), then click OK. NOTE: You can also change the destination folder 
in Step 6. 

Exhibit 3-3.  Change Folder Screen 

6.	 At the RMP*ReviewAdmin Setup Choose Installation Type Screen (Exhibit 3-4), click 
Typical to install RMP*ReviewAdmin. This screen gives you the option to change the 
destination folder (if you did not already do so in Step 5) or to Exit Setup. 
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Exhibit 3-4.  RMP*ReviewAdmin Setup

Choose Installation Type Screen


NOTE: The Typical, Custom, and Compact options are standard capabilities used in 
installing software, and are a part of the software component used for installing the 
RMP*Review System products.  Typical is used for installing a product in a vendor-
selected ‘standard’ way deemed to provide the most desired functionality for a product. 
Always select Typical when installing RMP*Review System products.  Custom is used to 
allow for non-standard functionality or for installing user-selected components of a 
product, such as might be needed to replace a particular component.  Compact is used for 
installing a vendor-selected set of components, typically requiring reduced hardware and 
system software resources and providing reduced functionality.  The Custom and 
Compact selections are not currently functional (nor are they currently needed) for 
installation of RMP*Review products. 

7.	 If the RMP*ReviewAdmin installation is successful, you will receive a screen message 
saying so.  If the installation is unsuccessful, you will receive an error message. 

3.2	 RMP*Review Data Installation 

1.	 Insert the installation CD into the CD-ROM drive. 

2.	 Click Start at the bottom left of the computer screen, then click Windows Explorer. 

3.	 Click on [CD-ROM drive]:\Review Data and double-click on setup.exe. 
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4. At the RMP*Review Data Setup Welcome Screen (Exhibit 3-5), click Continue. 

Exhibit 3-5.  RMP*Review Data Setup Welcome Screen 

5.	 At the RMP*Review Data Setup Destination Folder Screen (Exhibit 3-6), you are told 
that RMP*Review Data will be installed on your hard drive in C:\Program Files\RMP 
Review Data. If you are in a single-user environment and this is acceptable, click OK. If 
you are installing RMP*Review Data in a multi-user environment (where RMP*Review 
Data will reside on a LAN), click Change Folder and enter the LAN filepath at the 
Change Folder Screen (Exhibit 3-7.) 

Exhibit 3-6.  RMP*Review Data Setup Destination Folder Screen 

NOTE: You must designate the destination path for the RMP*Review data at this time as 
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Exhibit 3-7.  Change Folder Screen 
the destination path affects use of the Facilities List shortcut menu which uses the destination 
path. 

6.	 At the RMP*Review Data Setup Start Install Screen (Exhibit 3-8), click Install. 

Exhibit 3-8.  RMP*Review Data Setup Start Install Screen 

7.	 If the installation is successful, you will receive a screen message saying so.  If the 
installation is unsuccessful, you will receive an error message. 
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3.3	 RMP*Review Installation 

The DBA installs the RMP*Review software application on each user’s PC as follows: 

1.	 Insert the installation CD into the CD-ROM drive. 

2.	 Click Start at the bottom left of the computer screen, then click Windows Explorer. 

3.	 Click on [CD-ROM drive]:\Review, then double-click on setup.exe. 

4.	 At the RMP*Review Setup Installation Welcome Screen (Exhibit 3-9), click Continue, 
or click Exit Setup to end the install. 

Exhibit 3-9.  RMP*Review Setup Installation Welcome Screen 

5.	 At the RMP*Review Setup Destination Folder Screen (Exhibit 3-10) click OK to install 
the application in the default folder specified on the screen or click Change Folder to 
install the application to a folder of your choosing.  If you click Change Folder, choose 
the destination folder filepath at the Change Folder Screen (Exhibit 3-11) that appears 
and click OK. (NOTE: You will have another chance to change the destination folder in 
Step 6.) 
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Exhibit 3-10.  RMP*Review Setup Destination Folder Screen 

Exhibit 3-11.  Change Folder Screen 

6. At the RMP*Review Setup Choose Installation Screen (Exhibit 3-12), click the Typical 
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icon to install RMP*Review. This screen also gives you the option to change the 
destination folder (if you did not already do so in Step 5) or to Exit Setup. 

Exhibit 3-12.  RMP*Review Setup Choose

Installation Screen


7.	 If the RMP*Review installation is successful, you will receive a screen message saying so. 
If the installation is unsuccessful, you will receive an error message. 
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4.0 Loading RMP Data 

A. RMP data without the Offsite Consequence Analysis (OCA) sections is available for 
download from the following Internet web site: 
http://www.epa.gov/ceppo/93412785.htm 

Follow the instructions given on the web page to download the RMP data for the states of your 
choice. 

Before downloading any RMP state files, you should create a folder on your hard drive for storing 
the files.  Specify this folder when the web page asks you where to save each file.  This is also the 
folder that you should specify in Step 1 of the Import function in RMP*Review Admin, described 
in section 5.1 of the RMP*Review User Manual. 

These files are in zipped format, but you do not need to unzip them, since RMP*Review Admin 
will do that as part of the import process. 

B.  RMP data with OCA will be distributed on CD-ROM. 
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5.0	 RMP*ReviewAdmin 

The following sections provide the DBA of the RMP*Review System with step-by-step 
procedures to import RMP data, maintain the audit lookup tables, provide user-defined fields, and 
provide rank and scoring definitions.  RMP*ReviewAdmin and RMP*Review should not be in use 
at the same time. The DBA invokes RMP*ReviewAdmin as follows: 

1.	 Click Start at the bottom left of your computer screen, then point to Programs for a list of 
installed programs. 

2.	 Point to RMP ReviewAdmin in the list of programs; a sub-list of programs displays. 

3. 	Click on RMP Review Admin in the sub-list; the RMP*ReviewAdmin Main Menu 
(Exhibit 5-1) appears. 

Exhibit 5-1.  RMP*ReviewAdmin Main Menu 
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5.1	 Import Function 

Import allows an RMP*Review database to be populated as often as necessary with updated data 
for specific states or counties. Importing is divided into the following three phases: 

1.	 Locate a folder containing compressed state RMP data. 

2.	 Expand and convert the data to MS Access format and store in an intermediate database. 

3.	 Select the RMP database location to be used by RMP*Review and replace it with the 
intermediate database. 

These phases are done by performing the following series of steps: 

1. 	 To start the import process, click Import at the RMP*ReviewAdmin Main Menu; the 
Import Step 1 - Locate Folder with State(s) Data Screen displays (Exhibit 5-2). 

Exhibit 5-2.  Import Step 1 - Locate Folder with State(s) Data Screen 
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2. Click the Locate button; the Locate Zip DBF Folder Screen displays (Exhibit 5-3). 

Exhibit 5-3.  Locate ZIP DBF Folder Screen 

NOTE: To locate to a higher level in the folder directory structure, click the folder button 
to the immediate right of the Look in pick-list button. To locate to a lower level in the 
folder directory structure, click the Look in pick-list button; a list of sub-folders displays.  

3.	 Select the folder that contains the desired state RMP data, then click Next. The Import 
Step 2 - Convert State(s) Data Screen (Exhibit 5-4) displays showing those states that 
are in the folder. 
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Exhibit 5-4.  Import Step 2 - Convert State(s) Data Screen 

By default, all counties for all states that are in the selected folder are selected.  If you wish 
to convert data for only a subset of those states/counties, click the Clear All button, then 
click By County or All Counties as desired for each state you want to select.  If you click 
a By County check box for a state, a list of counties displays.  To select multiple counties, 
hold the Control key down and with the mouse, click on those counties you want to select, 
then release the Control key.  If you have multiple states, you can repeat the county 
selection process by just clicking the “by County” button for a new state. 

4. 	 To perform the conversion step, click Next and the Import Step 2 - Convert State(s) 
Data Confirmation Screen displays (Exhibit 5-5). 

Exhibit 5-5.  Import Step 2 - Convert State(s) Data Confirmation Screen 

5. 	Click OK to perform the conversion step. During the unzip process of the conversion step 
a MS-DOS window displays with messages as to the success of each state’s data 
unzipping.  When the unzip is complete, exit the MS-DOS window by clicking the close 
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(x) button in the upper right corner.  A Successful Unzip Confirmation Dialog Box 
displays (Exhibit 5-6).  Click Yes to acknowledge successful completion. 

Exhibit 5-6.  Successful Unzip Confirmation Dialog Box 

The data next goes through a conversion process.  When that is complete, a dialog box 
displays (Exhibit 5-7).  Click OK to acknowledge. 

Exhibit 5-7.  Message Complete Dialog Box 

6. 	 You are now ready to replace (or load for the first time) the RMP*Review database. The 
Import Step 3 - Replace an RMP Database Screen (Exhibit 5-8) displays. 
NOTE:  You should always backup the existing data before replacing it. 
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Exhibit 5-8.  Import Step 3 - Replace an RMP Database Screen 

To replace the RMP database with the unzipped and converted data from the previous 
step, follow the instructions in the displayed screen (Exhibit 5-8).  The default location for 
your RMP database is shown.  If you have moved the location of the RMP*Review Data 
folder, click Locate to select the new location. Click Finish to replace the RMP*Review 
database. A confirmation screen displays (Exhibit 5-9). 

Exhibit 5-9.  Replace RMP Database Confirmation Screen 

7. 	Click OK to confirm your intent to replace the database.  Another message dialog box 
displays when the database is replaced.  Click OK to acknowledge that the import process 
is complete.  NOTE: Once the database is replaced, remember to recalculate Rank and 
Scoring values. 
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5.2	 Audit Lookup Tables 

The DBA can add, delete, and modify values and descriptions stored in the RMP*Review Audit 
Lookup Tables by performing the following steps.  The DBA must have exclusive use of the 
RMP*Review database (i.e., no other users accessing it) while updating the Audit Lookup 
Tables. 

1.	 At the RMP*ReviewAdmin Main Menu (Exhibit 5-1), click Audit Lookup Tables, and 
the Select the Path to the RMP Database Dialog Box appears (Exhibit 5-10). 

If you have previously linked to RMP*Review Data, the filepath you last designated will 
appear in the window. If this filepath is still correct, you can click Attach to Database 
and go directly to Step 5. 

Exhibit 5-10.  Select the Path to the RMP Database Dialog Box 

2.	 To locate a filepath, click the ellipses button (...) and the Please Select Location Of Your 
RMP Data Dialog Box (Exhibit 5-11) appears, which allows you to browse the files for 
the RMP database location. (NOTE: The file will have an “.mdb” extension.) 

Exhibit 5-11.  Please Select Location of Your RMP Database Dialog Box 

3.	 Locate the desired filename and click Open. 

4.	 You are returned to the Select the Path to the RMP Database Dialog Box (Exhibit 
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5-10) with the filepath to the RMP database now entered. Click Attach to Database. 

5.	 The Audit Table Lookup Table Maintenance Screen (Exhibit 5-12) displays. 

This screen has the following fields: 

a.	 Personnel field: 

- Add a new person by clicking in the Name field, entering the name, and 
clicking Add. 

-	 Correct an existing name by selecting the name in the list block.  Correct 
the name in the Name field. After corrections are made, click Change. 

Exhibit 5-12.  Audit Data Lookup Table Maintenance Screen 

- Delete a person by selecting the name in the list block and clicking Delete. 
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b.	 Audit Status field: 

- Add a new audit status category by clicking in the Status ID field and 
entering a single-letter descriptor, such as “L” for “Late.”  Next, click in the 
Audit Status Description field and enter the description. Click Add; the 
added audit status category will appear in the list block. 

- Change an existing audit status description by clicking on the description in 
the list block. Make corrections in the Audit Status Description box. 
After all corrections are made, click Change. 

-	 Delete an audit status by clicking on its description and clicking Delete. 

c.	 Audit Type field: 

- Add a new audit type by clicking in the Type ID field and entering up to 
three numbers as a descriptor, such as “111”. Next, click in the Audit 
Type Description field and enter the description, such as “Combination 
Inspect/Audit.”  Click Add. 

- Change an existing audit type by selecting the type in the list block.  Make 
corrections in the Type ID and Audit Type Description boxes.  After all 
corrections are made, click Change. 

-	 Delete an audit type by selecting it in the list block  and clicking Delete. 

5.3	 User-Defined Fields Screen 

With the User-Defined Fields function, the DBA can define labels for as many as 13 definable 
fields.  One or more definable fields are provided for each of the following data types: text, date, 
check box, number, and memo.  The DBA requires exclusive use of the User-Defined database 
(i.e., no other users accessing it) to perform these functions. 

Assign the User-Defined Fields by performing the following steps: 

1.	 At the RMP*ReviewAdmin Main Menu (Exhibit 5-1), click User-Defined Fields, and 
the Select the Path to the RMP Database Dialog Box appears (see Exhibit 5-10). 
(NOTE:  If you have previously linked to RMP*Review Data, the filepath you originally 
designated then will appear in the window.  If this filepath is still correct, click Attach to 
Database and proceed to Step 5.) 

2.	 Click the ellipses button (...); the Please Select Location Of Your RMP Database Dialog 
Box (see Exhibit 5-11) appears, which allows you to browse the files for the RMP 
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database location. (NOTE: The file will have the extension “.mdb”.) 

3.	 Select the filename and click Open. 

4.	 You are returned to the Select the Path to the RMP Database Dialog Box (see Exhibit 5
10) with the filepath to the RMP database now entered. Click Attach to Database. 

5.	 A Database Opened In EXCLUSIVE Mode message appears.  Make sure no other users 
at your installation are using the RMP*Review System before continuing.  Click OK. The 
User-Defined Fields Screen (Exhibit 5-13) appears. 

Exhibit 5-13.  User-Defined Fields Screen 

Define entries in the Database Fieldname column to fit user needs. 

a. Go to the Change Description To box to make changes to the database 
fieldnames. 

b. Since the cursor is already flashing in the Change Description To box, begin 
typing. 

c. To go to the next field, press <Enter> or click with the left mouse button in the 
next field.  Complete all applicable entries. 
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5.4	 Ranking and Scoring 

The RMP*ReviewAdmin Ranking and Scoring function allows the DBA to define and customize 
ranking definitions and scores that will be available to RMP*Review users when they bring up the 
Facility List (see Section 6.1).  Both ranking definitions and scores can be saved and modified 
later by the DBA, if desired.  The ranking definitions and scores are stored in an MS Access 
database. For an example of Ranking and Scoring, see Appendix D. 

5.4.1	 Setup 

Perform the following steps to begin the ranking and scoring process: 

1.	 At the RMP*ReviewAdmin Main Menu (Exhibit 5-1), click Rank and Scoring. The 
Select the Path to the RMP Database Dialog Box appears (see Exhibit 5-10).  
If you have previously linked to RMP*Review Data, the filepath you last designated will 
appear in the window. If this filepath is still correct, click Attach to Database and skip to 
5.4.2 Scoring Tab. 

2.	 Click the ellipses button (...); the Please Select Location Of Your RMP Data Dialog 
Box (see Exhibit 5-11) appears, which allows you to browse the file system for the RMP 
database location. (NOTE: The file will have an “.mdb” extension.) 

3.	 Select the filename and click Open. 

4.	 You are returned to the Select the Path to the RMP Database Dialog Box (see Exhibit 5
10) with the filepath to the RMP database now entered. Click Attach to Database. The 
Create Ranking Criteria Screen displays.  Three tabs are available: Scoring, Ranking, 
and Calculate. The Create Ranking Criteria (Scoring Tab) Screen is the default screen 
to appear (Exhibit 5-14). 

5.4.2	 Scoring Tab 

The Create Ranking Criteria (Scoring Tab) Screen (Exhibit 5-14) is the DBA’s interface for 
defining and assigning weighting factors used with ranking definitions. 
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Exhibit 5-14.  Create Ranking Criteria (Scoring) Screen 

Perform the following steps to create scoring criteria: 

1.	 In the Score Name field, enter a unique name for the criterion that will be scored. 

NOTE: Table Name and Field Name entries are pre-set and cannot be altered by you. 

2.	 The Table Name pick-list contains the name of each table of the RMP for which ranking 
and scoring can be applied.  Choose the RMP table you want by clicking on it. 

3.	 The Field Name pick-list contains the data element description for each numerical data 
element in the section. 

4.	 Enter up to four thresholds in the boxes numbered 1 through 4 based on the following: 

a.	 You are provided with four pairs of text boxes for assigning weighting factors to 
the criteria. 

b.	 You may enter from one to four thresholds.  Threshold 1 must always have the 
highest value and each succeeding threshold must have a smaller value. 

c.	 If the values of the selected numerical data items exceed the thresholds, they  are 
assigned the scores you enter in the text boxes next to the thresholds.  Zero is an 
allowable value for the lowest threshold. Any value greater than zero, but less than 
the next greatest threshold entered, will receive the assigned score for the threshold 
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that it exceeded. 

d.	 In all instances, it is expected that the higher the threshold exceeded, the greater the 
assigned scores.  Thus, the highest aggregate score displayed in RMP*Review 
would be the likeliest candidate for audit and inspection. Conversely, when the 
user elects to display the numerical ranking in RMP*Review, the higher aggregate 
scores would translate into lower numerical rank values. 

5.	 Choose the method to score multiple records as follows: 

a.	 Facilities may enter multiple records for some sections of an RMP.  To provide you 
with flexibility in scoring, an option group labeled Choose method to score 
multiple records is available to the right of the Thresholds/Scores boxes. 

b.	 Select one of the two radio buttons—Highest value or All values. Highest value 
is the default.  Highest value means that only the highest data value for all 
submitted records by the facility is scored. 

c.	 Override the default by selecting All values. This will cause the application to 
tally aggregate scores for all submitted records by the facility. 

d.	 The Ranking and Scoring function also provides a method for selecting a specific 
“special” scoring criteria. 

Note that the Threshold/Score boxes and the Choose method to score multiple 
records option are dimmed if you select Process: Chemicals from the Table 
Name pick list.  In this case, the Maximum quantity of each regulated 
substance is divided by the threshold quantity from the Field Name pick list. 
This criteria will result in the integer ratio (up to a maximum of 10) for the 
reported quantity of the process chemical divided by the reporting threshold of the 
process chemical being aggregated for all process chemicals reported in the RMP. 

e.	 Use the position buttons at the bottom left of the screen—First, Previous, Next, 
Last—to view and edit previously stored criteria. 

f.	 Use the command buttons at the bottom right of the screen—Save, New, and 
Delete—to save changes, create new criteria, and delete existing criteria. 
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5.4.3	 Ranking Tab 

The Ranking tab (Exhibit 5-15) lets you establish sets of criteria as ranking plans 
(i.e., definitions). RMP*Review users may select any stored ranking plan(s).  The Ranking and 
Scoring function will calculate the aggregate scores for the current list of RMPs. 

Exhibit 5-15.  Create Ranking Criteria (Ranking) Screen 

Perform the following steps to create ranking criteria: 

1.	 The Rank Name combo box allows you to enter and save a new rank or display a list of 
previously saved definitions. 

a.	 Enter a description for a new ranking plan by clicking New Rank. You will be 
prompted to save the new rank to the list of Rank Names. Click Yes. 

b.	 Click the pick-list button (ó) to the right of the Rank Name field or press <F4> to 
display a list of previously saved ranking plan descriptions. 

2.	 The Score Name combo box displays the description for all criteria entered in the Scoring 
tab. You may select one or more criteria names and add them to the list box labeled Select 
scoring criteria to use with the current Rank Name by clicking Add to List. If the 
description for an existing ranking plan has criteria previously associated with it, the list 
box will be populated with the descriptive names of these criteria.  Other command 
buttons available are Delete Rank (without deleting any criteria), Edit Rank Name, add a 
New Rank, and Remove Criteria. 
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5.4.4 Calculate Tab 

Selecting the Calculate tab (Exhibit 5-16) displays a list of defined ranking names (if any 
defined). You may select one or more ranking definitions from list, then click the Calculate 
Scores button. You will get a message when all scores are calculated for each selected Ranking 
Definition. 

Exhibit 5-16.  Create Ranking Criteria (Calculate) Screen 

5.5 Facility Maintenance Function 

RMP*Review and RMP*ReviewAdmin provide the combined functionality to allow  users to 
create and maintain User Defined Data records and Audit records for facilities.  This 
functionality must relate User Defined Data records and Audit records to a facility and not to the 
RMPs submitted by that facility.  Three databases exist in the RMP*Review Data folder to 
support this requirement.  The User database consists of a single table that contains User 
Defined Data records.  The Audit database contains a table for Audit records and additional 
tables that contain lookup values for the RMP*Review Audit Form.  The Facility database 
contains a Facility table that has a single record for each facility that has had its RMPs imported 
into the RMP*Review database from the state dBase files.  These Facility records use the EPA 
Facility Identifier as the Primary Key for the table.  The RMP Identifier for the most current 
RMP imported into the RMP*Review database is another field in this table.  
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 Exhibit 5-17. RMP*ReviewAdmin Main Menu 

The User and Audit data tables contain the EPA Facility Identifier as a Foreign Key to the 
Facility table.  This distributed database structure, as implemented, meets the requirement to 
allow users to relate their User and Audit data to a facility rather than an RMP.  Additionally, 
the records in these databases are not removed if the user imports different RMPs, i.e., from a 
different state, into the RMP*Review database. The implementation of another requirement, 
also allows users to create User and Audit data for a non-reporting facility.  The term 
non-reporting is defined to mean any facility that has not submitted an RMP.  Agencies that use 
RMP*Review may use this capability to Audit facilities that they believe may be required to 
submit an RMP. 

The Facility Maintenance function described in the following sections provides the 
RMP*Review administrator (through RMP*ReviewAdmin) with the capability to remove 
facilities (and their User and Audit data) from the databases described above.  This would be the 
case if the agency no longer wished to track facilities that were once in their database.  An 
additional capability of the Facility Maintenance function allows the administrator to transfer 
User and Audit data records from a non-reporting facility to a reporting facility (with an EPA 
Facility Identifier) should the facility at some time submit an RMP. 
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The Facility Maintenance function may be activated by clicking the button labeled “Facility 
Maintenance” on the RMP*ReviewAdmin Main Menu or selecting Tools > Facility 
Maintenance from the RMP*ReviewAdmin Main Menu menubar.  The RMP*ReviewAdmin 
Main Menu is shown in Exhibit 5-17. 

Facility Maintenance Function User Interface 

Selecting the Facility Maintenance function will open the Facility Maintenance Form 
shown in Exhibit 5-18. 

Exhibit 5-18 . Facility Maintenance Form 

The list box in the center of the Form contains one row for each facility that has had an RMP 
loaded into the database.  The first column is the EPA Facility Identifier assigned to the facility. 
The second column is the name of the facility.  The third column displays the number of RMPs 
the facility has submitted.  The EPA Facilty identifier for a non-reporting facility will begin 
with the characters ‘NR’.  The number of RMPs in the database for a non-reporting facility will 
be 0.  The number of RMPs in the database will also be 0 for facilities whose RMPs are no 
longer in the database. 

The ‘Edit’ and ‘Add’ buttons in the bottom left portion of the Form provide the administrator 
with the capability to Add a new non-reporting facility or edit one that had been previously 
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added.  Exhibit 5-19 shows the Add/Edit Form for a non-reporting facility. 

Exhibit 5-19.  Add/Edit Non-reporting Facility Form 

The ‘Delete’ button provides the capability to delete a non-reporting facility, or a facility 
without RMPs in the database.  Clicking this button opens the Delete Old Facilities Form shown 
in Exhibit 5-20.  Deleting a facility will also delete related User, Audit, and Ranking and 
Scoring records from the database.  Users may select one or more such facilities at a time, from 
the displayed list, for deletion. 

The ‘Tranfer ID’ button provides the capability to transfer the User and Audit data for a 
non-reporting facility, or a facility without RMPs in the database to a reporting facility as 
described earlier.  Clicking this button opens the Transfer Data to New EPA Facility Identifier 
Form shown in Exhibit 5-21. 
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Exhibit 5-20.  Delete Old Facilities Form 
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Exhibit 5-21.  Transfer Data to New Facility Identifier Form 

To transfer Audit and User Defined data from a non-reporting to reporting facility, select a non-
reporting facility from the upper list box and a reporting facility from the lower list box.  The 
“Transfer:” Audit Data and User Defined Data check boxes at the top of the Form provide the 
user with the capability to select which data to transfer.  The “Delete Source EPA Facility 
Identifier after Transfer” check box at the bottom of the Form provides the user with the 
capability to delete the selected facility (upper list box) from the database after the transfer is 
complete. 

The “Close” and “Cancel” bottons in the lower right corner of the Forms described above close 
the opened form.  Note: The “Cancel” button on the “Transfer Data to New EPA Facility 
Identifier” Form does not undo a transfer of data after it has completed.  It only closes the Form. 
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6.0	 RMP*REVIEW 

This section contains the procedural steps for using the RMP*Review application. RMP*Review 
provides EPA HQ, regions, states, and LEPCs with the ability to evaluate and analyze RMPs. To 
invoke RMP*Review perform the following steps: 

1.	 Click Start at the bottom of your computer screen, then point to Programs for a list of 
your installed programs. 

2.	 Point to RMP Review; a sub-list displays.  Click on RMP Review in the sub-list.  after a 
few seconds the RMP*Review Main Menu (Exhibit 6-1) appears. 

Exhibit 6-1.  RMP*Review Main Menu 

It is possible to have more than one RMP database.  The location of the most recent database 
accessed is shown near the bottom of the RMP*Review Main Menu followed by the date and 
time when it was refreshed. Be sure that you access the intended database. 
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6.1	 Attach Database 

Perform the following steps to attach to an RMP*Review database: 

1.	 At the RMP*Review Main Menu (Exhibit 6-1), click Attach Database; the Attachment 
Manager Dialog Box (Exhibit 6-2) appears.  You need only select the 
[path]\RMPData.mdb file.  The Attachment Manager will attach to all five database 
files. 

Exhibit 6-2.  Attachment Manager Dialog Box 
If you previously attached an RMP*Review database, the filepath you last used appears in 
the window. If it is still correct, click Reattach, which will bring you back to the main 
menu. If the filepath has changed and you remember it, enter it in the window, then click 
Reattach. If the filepath has changed and you don’t remember it, or this is an initial 
access, proceed to Step 2. 

2.	 To search for the location of the RMP*Review Data, click the ellipses (...); the Please 
Select Location of Your RMP Data Dialog Box (Exhibit 6-3) appears. 

Exhibit 6-3.  Please Select Location of Your RMP Data Dialog Box 

This allows you to browse the file system for the RMP database location.  For example, in 
a single-user environment, the location will likely be your hard drive: 
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C:\Program Files\RMP Review Data\RMPData.mdb. 

In a LAN (i.e., multi-user) environment, the location will likely be similar to: 

[LAN drive]:\[path]\RMP Review Data\RMPData.mdb. 

6.2 Facility List 

The Facility List function allows you to search for RMPs by address, display a facility’s score and 
numerical rank with respect to risk criteria established by your RMP*Review System DBA, create 
queries, review the most current RMPs or all RMPs (historical record), sort on different list 
columns, enter facility audit data, enter user-defined data, generate reports, export data, display 
online help, and print the Facility List. 

To display the Facility List, click Facility List at the RMP*Review Main Menu; the List of 
Facilities Screen (Exhibit 6-4) appears with the following columns: 

C Facility Name – The name of the facility that was entered and registered into the 
database. 

C EPA Facility ID – An EPA-assigned, numerical facility identifier. 

C Score/Ranking – At the top left corner of the screen you can choose to Display 
the Facilities by Score or Numerical Ranking. When the Score radio button is 
selected, aggregate scores for facilities are displayed.  When the Numerical 
Ranking radio button is selected, ordinal ranks for facilities are displayed. 

C Number of RMPs – The number of RMPs on record for the facility. 
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Exhibit 6-4.  List of Facilities Screen 

To generate an RMP Facility List report (in a document list format) for those facilities displayed 
at the List of Facilities Screen, click File > Reports > RMP Facility List. Click the left mouse 
button once to zoom in.  Click again to zoom out.  Use the slide bars on the report screen to move 
the screen view area. Use the navigation buttons at the bottom of the screen to move to different 
pages.  To print the report, click the printer icon at the top left of the report screen. HINT: To 
search for a specific value in a column, click <ctrl+f> to invoke an MS Access search window. 
This is not the same as the Facility Search function described in 6.2.2. 

6.2.1 Display Scores or Numerical Ranks 

Ranking and scoring criteria are defined by your RMP*Review System DBA.  You can click 
Choose Ranking at the RMP*Review Main Menu to select from the defined criteria. Then, at the 
List of Facilities Screen, click on either the Score or Numerical Ranking radio button to display 
aggregate scores or ordinal rankings for the facilities in the list.  See Appendix D for an example 
of Rank and Scoring. 
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6.2.2 Search for a Facility 

You can search for a facility at the List of Facilities Screen (Exhibit 6-2) by clicking the Search 
Facility List by Name and Location button. The RMP Facility Search Screen displays 
(Exhibit 6-5).  Enter as much information as you know about the facility for which you are 
searching and click Go. If multiple RMPs match the entered criteria, each facility will be 
displayed in the List of Facilities Screen. To reset the list such that all facilities are redisplayed, 
place the cursor pointer anywhere on the list, click the right mouse button for the shortcut menu, 
then click Reset Facility List. A second method to reset the facility list is to re-enter the RMP 
Facility Search Screen and click Go with all fields blank. 

Exhibit 6-5.  RMP Facility Search Screen 

6.3 RMPs 

At the List of Facilities Screen (Exhibit 6-4), click All RMPs so that all RMPs, both current and 
historical, will display when RMP detail is requested, or click Current RMPs Only if you only 
want to view detail for the most recent RMPs. To view RMP detail for a facility, click on the 
facility name, then click the View RMP Detail button, or double-click on the specific facility 
name; the RMP Detail Screen (Registration Information) (Exhibit 6-6) for the facility’s most 
recent RMP is displayed. 

6-5




Exhibit 6-6.  RMP Detail Screen (Registration Information) 

You can view the various sections of an RMP record using the Section buttons at the top of the 
detail screens.  To initiate a Query By Form (QBF) for filtering out a subset of RMPs, as 
described in Section 6.8, click the Query (QBF) button. To revert back to the pre-QBF set of 
RMPs, click Reset QBF. The Close RMP button closes the RMP detail screen. 

You can navigate through RMP records using the navigation buttons provided at the bottom of the 
screens. Also, at the menu bar, Records > Go To allows you to navigate through records. 
Choose from the following: 

C First: Moves you to the first record. 
C Previous: Moves you one record back. 
C Next: Moves you one record forward. 
C Last: Moves you to the last record. 

6.3.1 Viewing RMPs 

You can view RMPs in one of two ways by clicking View at the menu bar of an RMP detail 
screen, then choosing one or the other of the following: 

C	 Form View: This default view is a standard vertical screen format. 

C	 Datasheet View: This optional view arranges the screen into horizontal rows and columns 
like a spreadsheet. This view can be customized with columns reordered and resized. 
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HINT: <ctrl+f> opens the MS Access search window, if your want to search for a specific 
value in a column. 

6.3.2 Synchronized Viewing of Multiple RMP Sections 

Clicking Window > Tile Horizontally at the menu bar allows you to view muliple sections of an 
RMP simultaneously.  This is a powerful feature when used with QBF filtered records.  You can 
use the navigation control on any of the displayed sections, and all other sections will be updated 
to the current RMP. NOTE: Minimizing the Main Menu and List of Facilities Screen before 
tiling will maximize the viewing area for displaying RMP sections. 

6.3.3 Sort RMP Data 

Sorting can be done at several RMP*Review screens from either a shortcut menu (right mouse 
click) or via the screen’s menu bar (Records > Sort). Choose either Sort Ascending or Sort 
Descending. To undo a sort, from the menu click Records > Filter > Remove Filter. 

As an example, suppose you want to identify RMPs that have been received since a specific date. 
Section 1 of RMPs contain the receipt date.  At the List of Facilities Screen click on any facility 
name with an RMP to display the RMP detail screen.  Locate the Receipt Date (near the bottom of 
Section 1) and click on the field.  The Receipt Date field then becomes the field of focus.  Now 
perform a Sort Descending; RMPs will now be in descending Receipt Date order.  Using the 
navigation buttons at the bottom of the RMP Section 1 detail screen, you can now easily view the 
RMPs of interest. (You could also have used the Query By Form or Query by Example features 
of RMP*Review to select just those RMPs with a Receipt Date greater than a date that you 
specify.  NOTE: Query By Form is most effective when the form is in Datasheet View.) 

6.3.4 RMP Detail Report 

From an RMP Detail Screen, or at the List of Facilities Screen with a facility selected, click File 
> Reports > RMP Detail to bring up an RMP Report Options Dialog Box (Exhibit 6-7).  This 
allows you to customize a report by clicking the desired check boxes corresponding to a facility’s 
RMP sections. Clicking the Entire RMP check box means all sections of the RMP will appear in 
the report.  To review the report prior to printing, click Preview. When previewing an RMP 
detail report, you can use the navigation buttons to move through the pages.  Print the report by 
clicking Print. To export the report to a file, click Export. 
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Exhibit 6-7.  RMP Report Options Dialog Box 

Note the Print Multiple RMPs check box in the upper right hand corner of the RMP Report 
Options Dialog Box. Click this box, then the Print button to display the PrintMultipleRMPs 
List Screen (Exhibit 6-8).  This dialog box allows you to select more than one RMP to print at a 
time.  RMPs in this list will also reflect any QBF filtering performed. 

Exhibit 6-8.  Print Multiple RMPs List Screen 
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6.3.5	 RMP Errors 

When a facility submits an RMP that contains errors, the EPA Reporting Center generates an 
Error Report.  This report details the error(s) and requests a resubmittal of the RMP.  To view the 
Error Report generated for a facility, select the facility (single click) at the List of Facilities 
Screen, then click File > Open > RMP Errors. A No Errors message box will appear if the 
facility has no errors. 

6.4	 RMP Tracking System 

For the states imported by the DBA, you can check RMP Tracking System information, as logged 
by EPA’s Reporting Center, to see if any facilities’ RMPs have been rejected by the Center. 
Perform the following steps to check RMP Tracking System information: 

1.	 Click on RMP Tracking System at the RMP*Review Main Menu (Exhibit 6-1). 

2.	 The RMP Tracking System Facility List (Exhibit 6-9) is displayed with the first tracking 
record selected. Click on the keys next to Record at the bottom of the screen to scroll 
through the records. 

Exhibit 6-9.  RMP Tracking System Facility List 
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6.5 Facility Audit Data 

You can view existing audit records and create new audit records.  When creating records 
enter/select facility audit data: date, type, status, personnel, and comments.  Audit types, statuses, 
and personnel are entered by the DBA and are accessible via pick-list buttons (ó) in 
RMP*Review. To access or create audit data for a facility, click on the facility name at the List of 
Facilities Screen, then click File > Open > Audit Data at the menu bar. The latest audit data for 
a facility is displayed at the RMP*Review List of Audits Screen (Exhibit 6-10). 

Exhibit 6-10.  List of Audits Screen 

Double click on a record-selector arrow to view the record’s audit data; the RMP*Review Audit 
Information Screen (Exhibit 6-11) displays (and it would have data in the fields).  If multiple 
audits have been performed for a facility, use the navigation buttons at the bottom left of the 
RMP*Review Audit Information Screen to view them. 

If no audit records exist for the facility, the Create an Audit Record Dialog Box (Exhibit 6-12) 
appears. To add a new audit record, click Click Here To Add A New Audit Record For This 
Facility; an RMP*Review Audit Information Screen (Exhibit 6-11) with blank fields displays. 

6-10




Exhibit 6-11.  RMP*Review Audit Information Screen 

Exhibit 6-12.  Create an Audit Record Dialog Box 

To generate an RMP audit report for a selected facility at the List of Facilities Screen, or at an 
RMP detail screen, click File > Reports > RMP Audit Data at the menu bar. Print the report by 
clicking the printer icon at the top left of the report screen. 

6.6 User-Defined Data 

You can view and update data in User-Defined fields associated with facilities. User-Defined 
fields are defined by the RMP*Review System DBA using RMP*ReviewAdmin. One or more 
definable fields are provided for each of the following data types: check box, date, text, number, 
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and memo. To access or enter user-defined data for a facility, click on the facility name at the 
List of Facilities Screen, then click File > Open > User Data at the menu bar. The Additional 
User-Defined Data Screen (Exhibit 6-13) displays. 

Exhibit 6-13.  Additional User-Defined Screen 

To generate a report of user-defined RMP data for a selected facility at the List of Facilities 
Screen, or at an RMP detail screen, click File > Reports > RMP User Data at the menu bar. 
Print the report by clicking the printer icon at the top left of the report screen. 

6.7 Generate Mailing Labels 

Mailing labels can be generated from the menu bar.  Be aware that labels for an entire state could 
result in hundreds of pages of labels.  Generally, you will want labels for only a subset of the full 
list, such as for a specific city or county.  To get a filtered list of facilities for mailing labels, click 
Query (QBF) at an RMP detail form (e.g., Exhibit 6-6) before selecting for mailing labels.  The 
Query By Form (QBF) capability is described in Section 6.8. 
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To generate mailing labels at the List of Facilities Screen or from an RMP detail screen, click 
File > Mailing Labels at the menu bar; the Mailing Label Utility Screen displays (Exhibit 6-14). 

Exhibit 6-14.  Mailing Label Utility Screen 

Click the pick-list button to the right of the Avery Label Forms field; a list of acceptable forms is 
displayed (Exhibit 6-15).  Select the form you wish to use. 

Exhibit 6-15.  List of Acceptable Forms for Mailing Labels 

The labels can be addressed directly to the facilities in the Facility List by leaving the Line 1 field 
blank, or they can be addressed to specific individuals registered for the facilities by clicking on 
the down arrow to the right of the Line 1 field and selecting from the list (see Exhibit 6-16). 

Exhibit 6-16.  Line 1 Addresses for Mailing Labels 
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Click the Preview button to display an on-screen sample of what the labels will look like; a row 
of icons will display near the top of the screen.  To print the labels, click the printer icon, or, at the 
menu bar click File, then Print. NOTE: If labels are set to print double sided you will have to 
temporarily disable this feature.  Click File > Page Setup at the menu bar of the RMP*Review 
[rpt form : Report] preview screen, then click the Page tab of the Page Setup screen. At the 
Page screen, click the Specific Printer radio button, then click the Printer button. You can then 
click Properties to select single sided printing. 

6.8 Query by Form (QBF) 

The QBF capability is one of several decision support tools provided within RMP*Review. QBF 
provides an easy graphical interface for limiting the number of RMPs displayed at any time.  QBF 
is a filtering tool for selecting RMPs based on criteria that you specify. 

6.8.1 Background 

RMPs are initially filtered using one function of RMP*ReviewAdmin and one of RMP*Review. 
First, the Import function in RMP*ReviewAdmin allows the DBA to include data for one or more 
states in the RMP*Review database. Second, with RMP*Review you can view all RMPs 
submitted by a facility or only the most current RMP.  You see the data in a format similar to the 
facility’s actual RMP*Submit data entry forms, except that the data in RMP*Review is read-only. 
A third method of filtering is available with the QBF tool.  That is, you can use the QBF tool to 
individually tailor the set of RMPs you are working on at your PC. 
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6.8.2 User Interface 

You can start a QBF session while viewing any section of an RMP by clicking the QBF button 
near the bottom of the screen.  Alternately, you can select Query By Form from the shortcut 
menu that is displayed by clicking the right mouse button while the cursor is on the displayed 
section. NOTE: The shortcut menu displayed when you click on a sub-screen embedded within a 
section’s main screen does not contain the Query By Form option. 

The QBF screen is a duplicate of the currently displayed section’s screen with all fields blanked 
out. You may enter search criteria in one or more fields and click OK to return all records for that 
section based on the search criteria.  More importantly, the results of the search change the list of 
viewable RMPs.  The results of entering search criteria in one or more QBF screens for multiple 
sections of an RMP will likely decrease the number of RMPs that may be “viewable” without 
needing to return to the List of Facilities Screen. QBF filtering is reflected in mailing labels and 
in the Print Multiple RMPs List Screen (Exhibit 6-8). 

6.8.3 Filtered Records vs. QBF Returned Records 

At this point it is important to understand that there is an inherent filtering going on behind the 
scenes in RMP*Review.  When you initially select a facility name from the List of Facilities 
Screen, the Registration Information data for all RMPs is loaded for viewing.  An RMP for the 
selected facility is initially displayed, regardless of its placement within the set of RMP 
Registration Information records.  Other sections of the currently displayed RMP may be viewed 
by clicking on the desired section number (Section 1, Section 2, etc.) from the tool bar at the top 
of the screen. When the desired section is displayed, note that next to the navigation buttons (in 
the lower left-hand portion of the window) is the word “Filtered.” This means that if you 
selected Section 2, Toxics Worst Case Scenarios, while viewing the Registration Information for 
facility XYZ, only the Toxics Worst Case Scenarios for XYZ’s RMP are available for viewing. 

If XYZ did not report any Toxics Worst Case Scenarios, the screen will be blank (gray).  This 
background “Section filtering” may be removed by selecting Records, Filter, Remove Filter 
from the menu. The capability to remove the filter is also available by right-clicking for the 
shortcut menu. 

Once a section’s filter is removed, you may bring up the section’s QBF screen as described 
earlier.  If the filter is not removed, the QBF capability can only act on the displayed records—not 
the entire set of records for that section. When QBF filtering has been applied, the text “QBF is 
On” is displayed in red in the right-hand portion of the footer at the bottom of the window.  QBF 
filtering can be removed by clicking Records, Filter, Reset Query from the menu bar. This step 
will remove QBF filtering for all RMP sections. 
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6.8.4	 Specifying QBF Search Criteria 

You can search for four data types within QBF using the Text, Numeric, Date, and Yes/No check 
boxes. 

C	 Text fields: Text field searches support the standard Windows wildcard characters ‘*’ for 
one or more characters and ‘?’ for a single character.  Regular expressions are also 
supported. The topic of using regular expressions in text searches is beyond the scope of 
this document but using square brackets ([ ]) will be discussed because they are necessary 
for successfully using QBF.  If the text you are searching for contains the wildcard 
characters ‘*’, ‘?’, or ‘#’, the character must be enclosed in square brackets.  The list that 
follows describes the use of square brackets. 

Characters in Pattern Matches in String 

?	 Any single character 
* Zero or more characters

# Any single digit (0–9)

[charlist] Any single character in charlist

[!charlist] Any single character not in charlist


A group of one or more characters (charlist) enclosed in square brackets ([ ]) can be used 
to match any single character in a string (at the position in the string where the brackets are 
located) and can include almost any character code, including digits. 

NOTE: To match the special characters left bracket ([), question mark (?), number sign 
(#), and asterisk (*), enclose them in brackets. The right bracket (]) cannot be used within 
a group to match itself, but it can be used outside a group as an individual character. 

By using a hyphen (-) to separate the upper and lower bounds of the range, charlist can 
specify a range of characters.  For example, [A-Z] results in a match if the corresponding 
character position in a string contains any uppercase letters in the range A-Z.  Multiple 
ranges may be included within the brackets without delimiters. 

To search for string “xyz,” starting at the leftmost position enter “xyz” without the 
quotation marks in the field. This will return all records starting with xyz (either the 
whole word or the beginning of the word).  To search for “xyz” embedded within the text, 
enter “*xyz” without the quotation marks in the field.  QBF always assumes there is an 
asterisk (*) after the text unless the user prefaces the text with an equal sign (=).  The 
equal sign is used to search for exact matches of the entire field.  The syntax is =‘xyz’ 
where the tic marks (single quotation marks) are required.  If the user is searching for text 
that has embedded tic marks, use double quotation marks (“ ”) to surround the text string. 
NOTE: QBF always performs embedded searches for RMP Executive Summary text. 
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Certain numerical data, such as latitude and longitude measured in degrees, minutes, and 
seconds, are stored in the database as text fields.  You can still construct boolean-type 
searches by enclosing the value in single quotation marks.  For example, to return all 
facilities whose latitude is greater than 40 degrees, enter >‘40’.  NOTE: QBF performs a 
character-by-character comparison, from the left-most character, for text searches. 

C	 Numeric fields: Numeric field searches support any legal combination of the boolean 
operators >, <, =, and NOT. The keywords ‘IN’ and ‘Between...And’ are also supported. 
It is assumed that you are familiar with constructing numeric search criteria. NOTE: The 
‘Between...And’ key words may also be used in the previous text example (i.e., the one 
with a latitude of 40 degrees).  Between ‘40’ and ‘405’ would return all facilities with 
latitudes between 40 degrees and 40 degrees 50 minutes. 

C	 Date fields: Date parts must be separated by slash marks (/).  For example, January 3, 
1999, is represented as 1/3/1999. Date field searches support any legal combination of the 
boolean operators >, <, and =. ‘Between...And’ is also supported.  When using boolean 
operators or the ‘Between...And’ keywords, the date(s) must be enclosed in hash marks 
(#). The proper syntax for ‘Between...And’ using dates is as follows: 

BETWEEN #01/01/1997# AND #04/15/1998# 

NOTE: The beginning and ending values are included in the search. 

The NOT operator is not supported in ‘Between...And’ date searches. 

Because wildcard characters, such as *, are treated as literals, you cannot use them with 
the ‘Between...And’ operator.  For example, you cannot use 980* and 989* to find all 
postal codes that start with 980 to 989. Instead, use one of the following two alternatives. 
One, you can add an expression to the query that takes the left three characters of the text 
field and uses ‘Between...And’ on them.  Two, you can pad the high and low values with 
extra characters— in this case, 98000 to 98999, or 98000 to 98999 – 9999 if using 
extended postal codes. 

C	 Yes/No Fields: Yes/No data types are represented by check boxes in QBF screens.  The 
check boxes may have one of three states: checked, not checked, or Null.  The check box 
is grayed-out when it is in the Null state.  Thus, to search for conditions where a check box 
is not checked, proceed as follows: 

- Click the grayed-out box to select it (checked).

- Click again to de-select it (not checked).
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6.8.5 Compound Searches 

The QBF facility used by RMP*Review allows you to enter compound search criteria where each 
field entered is a unique criteria. It also allows you to enter compound search criteria in a single 
field. 

As an example, if you had the states of Kansas and Missouri in your database, a compound QBF 
would be easy to use if you wanted to filter for all RMPs for facilities in Kansas City, MO.  You 
would enter Kansas City in the City field and MO in the state field (so as not to select RMPs for 
Kansas City, KA facilities).  However, if you wanted to filter for all RMP’s in Topeka, KA and 
Kansas City, KA at the same time, you must enter: 

= ’Topeka’ Or = ’Kansas City’ in the City field and KA in the State field. 

Note: The equal sign must precede each city name and single quotes are required around each city 
name because the City field is a text field.  Single quotes are not required in the state field because 
the state abbreviation is not preceded by an equals sign (the equals sign is needed in order for the 
QBF function to parse the compound criteria in the City field correctly.) 

6.9 Advanced QBE 

Advanced QBE is a tool for designing complex, custom queries for reports or for export to a 
foreign format.  Use the procedures in the subsections that follow to utilize the Advanced QBE 
tool. See Appendix H for examples of QBE. 
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6.9.1	 Getting Started 

1.	 Access the Advanced QBE tool by clicking Advanced QBE on the RMP*Review Main 
Menu or, if you are already in the Registration Information Screen, by clicking the File 
Menu, then Advanced QBE button. 

2.	 The Advanced Query by Example (QBE) Screen (Exhibit 6-17) appears. 

Exhibit 6-17.  Advanced Query by Example (QBE) Screen 

3.	 Two tabs are available: Design a Query by Example and Write a Custom SQL Query. 
(Section 6.9.2 covers Design a Query by Example, and Section 6.9.3 covers Write a 
Custom SQL Query.) 

4.	 Regardless of which tab is chosen, there are action buttons on the menu bar in the screen’s 
footer that allow you to perform the following: 

C View: Runs your query and allows you to view the query results. 
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C Load: Allows you to load your previously created and saved QBE queries.  Within 
Load, you can choose: 

-
-
-
-

Delete: Deletes the selected query. 
Rename: Renames the selected query. 
OK: Brings up the selected query. 
Cancel: Takes you out of load without loading a saved query. 

C Save: Saves the current query.  NOTE: The screen is saved automatically every 
time you leave it. 

C Export: Allows you to export your query results to one of the following foreign 
file types: 

-
-
-
-
-

Lotus (WKS, WK1). 
MS Excel (XLS). 
Text (TXT). 
MS Access Table. 
Hypertext Markup Language (HTML). 

C SQL: Allows you to view the SQL statement created by the QBE tool. 

C New: Brings up an empty screen at the point you are currently located. 

C Cancel: Exits the Advanced QBE function. 
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6.9.2	 Design a QBE 

Perform the following steps to design a QBE: 

1.	 Click the down arrow (ó) to the right of the Table selection box to see a combo box of 
data table descriptions (Exhibit 6-18).  Table relationships are provided in Appendix F. 

Exhibit 6-18.  Advanced QBE Screen with Table Combo Box 
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2. Select a data table description from the combo box to see a list of all data fields belonging 
to that table in the AVAILABLE block (Exhibit 6-19). 

Exhibit 6-19.  Advanced QBE Screen Showing Data Fields for a Selected Table 

3.	 Below the AVAILABLE block is a Sort List check box.  If you double click on an entry 
in the AVAILABLE block, a Table_x check box appears under the Sort List check box. 

C	 Sort List: If you check this box, the list of fields is alphabetized to help you look 
for a given field.  If the box is not checked, the list of fields is in the default order 
of the table itself. 

C	 Table_x: For complex queries, Table_x allows you create a copy of the table so 
that you can use the same table twice.  For example, you may want to form a query 
that identifies a single RMP facility that was assigned two different EPA facility 
identifiers. The problem is that you would need to join tblS1Facilities to itself so 
you create a duplicate of tblS1Facilities, which will be referred to as 
tblS1Facilities_1. 
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4.	 Once you know the field or fields that you want in your query results, double-click on the 
field(s) to move them into the SELECTED block (Exhibit 6-20).  The blue single arrows 
(|) move the selected field in the appropriate direction. The blue double arrows (�) 
move all fields in the appropriate direction. 

Exhibit 6-20.  Advanced QBE Screen with Table Fields Copied to SELECTED Block 

The SELECTED list block contains the following three columns of information: 

C Field - holds the field name.

C Table - holds the name of the table from which the field was drawn.

C Show - features a small “x” to indicate whether or not you want the value of that


field to be visible when the query is run.  Usually, you will want to see all values 
but not always.  To not show a field, use your right mouse button to toggle the x 
off (x not visible).  To make the field visible again in the query, use your right 
mouse button to toggle the x on. 

If you selected a field that you do not want in your query results, you can double-click on 
the field to delete it from the SELECTED list block or use the arrow command buttons. 
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5.	 Below the SELECTED list block is a Sort List check box.  If you double click on an 
entry in the SELECTED block, a Table_x check box appears next to the Sort List check 
box.  (Use of these check boxes is the same as in Step 3.) 

6.	 The Table Joins button is located below the SELECTED list box and is used to show the 
table joins that Advanced QBE has attempted to make.  Table joins are how different 
tables are related to each other.  The joins that Advanced QBE tries to make may not 
always be right because the tables have to be selected in the proper order for it to work 
correctly.  You may edit the table joins after pressing the Table Joins button. 

Example: If you want address information and flammable mixtures, you form the query by 
selecting the tblS1FlammableMixtureChemicals, tblS1ProcessChemicals, 
tblS1Processes, and tblS1Facilities. The default joins created are incorrect.  To remedy 
this, click on Default Joins from within Table Joins. 

There are three types of joins.  They are as follows: 

C	 Inner Join: Pulls up records only when there is a match on both sides of the join. 

C	 Left Outer Join: Pulls up all values from the left table and any associated values 
from the right table.  A left join physically means that you want all values from the 
table that are on the left. 

C	 Right Outer Join: Pulls up all values from the right table and any associated 
values from the left table.  A right join physically means that you want all values 
from the table that is on the right. 

The default join is always an inner join.  To change to an outer join, click on the down 
arrow to the right of Join Type and change to the appropriate join. 

7.	 Beneath the Sort List and Table Joins options is the Where box.  A Where Clause 
specifies any conditions (if any) that must be met by the query.  For example, if you want 
to see only RMPs that have a facility name beginning with “AL,” you have to specify this 
condition in the Where Clause as follows: 

a.	 Click the applicable entry in the SELECTED list box and click the Where button. 

b.	 The table and field names appear in the Where text box, enclosed in square 
brackets and separated by a period.  It should look like as follows: 

[tblS1Facilities].[FacilityName]= 

c.	 You have to specify the condition (i.e., = x).  It should look as follows: 
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[tblS1Facilities].[FacilityName] Like “AL*” 

You can change the equal sign in Where Clauses to other operators and expressions, such 
as <, >, <>, and Like.  NOTE: You can press <Shift + F2> to expand the Where box for 
easy viewing. 

You can have a very involved Where Clause with compound conditions, such as the 
following example: 

([tblS1Facilities_1].[FacilityID] <> [tblS1Facilities].[FacilityID] AND 
[tblS1Facilities].[FacilityName] =[tblS1Facilities_1].[FacilityName] AND 
[tblS1Facilities].[FacilityStr1] = [tblS1Facilities_1].[FacilityStr1] AND 
[tblS1Facilities].[FacilityStr2] = [tblS1Facilities_1].[FacilityStr2] AND 
[tblS1Facilities].[FacilityCity] = [tblS1Facilities_1].[FacilityCity] AND 
[tblS1Facilities].[FacilityState] = [tblS1Facilities_1].[FacilityState] AND 
[tblS1Facilities].[FacilityZipCode] = [tblS1Facilities_1].[FacilityZipCode] AND 
[tblS1Facilities].[EPAFacilityID] <> [tblS1Facilities_1].[EPAFacilityID]) 

Another example would be to show all RMPs in Maryland that process the chemical 
ammonia. To do this, fill out your first condition for choosing all RMPs in Maryland 
(Like “MD*”), then go back to the SELECTED list box, select chemical name, and click 
Where again.  The new chemical name field will be added to the text box and joined to 
the first condition by the word AND (the default).  Fill in the where clause (= “ammonia”). 
You can change the AND to an OR if necessary. 

You can also use the Where box to set up a parameter query.  For example, you may want 
to run a query but only change the chemical stored.  (You can do this for any field 
selected). To do this, set up the Where Clause to look like this: 

[tlkpChemicals].[ChemicalName]=[Enter the Chemical] 

Running the query will prompt you to enter the chemical.  You could have said [Enter 
Chemical] or [what is the Chemical?]. This type of query can come in handy when 
asking the same information for different facilities or RMPs.  Also, you are not limited to 
just one parameter in the Where Clause. 

8.	 Below the Where box is the Order By box, which is used to sort query results.  Its use is 
similar to the Where box above.  Use the Order By box as follows: 

a.	 Select a field from the SELECTED list box. 
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b.	 Click the Order By button. Additional fields can be added to order by repeating 
these two steps.  NOTE: <Shift F2> will expand the Order By box for easy 
viewing. 

c.	 The order in which the fields are added to the Order By box determines the order 
of the sorts. For example, if the order box looks like this: 

[tblS1Facilities].[FacilityState],[tblS1Facilities].[FacilityName] 

then, the order would be first by facility state and then by facility name. 

d.	 By default, sorts are in ascending order.  To sort in descending order, add DESC 
after your ordering list.  For example, if you want to sort by descending Chemical 
Quantity size, the Order By box would be: 

[tblS1ProcessChemicals].[Quantity] DESC 

9.	 After you have provided the basic criteria for your query, you have up to four ways to limit 
the Record Selection that meet your general selection criteria specified in the Where box. 
They are: 

C	 All: If you do not choose one of the other options, All is assumed and Advanced 
QBE selects all records that meet the conditions in the query statement.  Keep in 
mind that using the All predicate may return duplicate information that you do not 
want to see. 

C	 Top: Clicking on the Top button allows you to pull up a certain number of records 
that fall at the top or the bottom of a range specified by an Order By clause. 
When you click on the Top button, the adjacent text box becomes activated so you 
can enter the number of records you want returned. 

To get the top 10 of something, simply choose Top and enter 10 in the adjacent 
text box.  NOTE: If there is no field name entered in the Order By box, the query 
will return an arbitrary set of records that satisfy the conditions entered in the 
Where Clause. 

C	 Distinct: Use the Distinct button when you want to omit records that contain 
duplicate data in your selected data fields.  To be included in the results of the 
query, the values for each field listed in the SELECTED list box must be unique. 

C DistinctRow: Use the DistinctRow button when you want to omit data based on 
entire duplicate records, not just duplicate fields. 
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By using Distinct, DistinctRow, or Top, your query output is filtered after all other 
clauses in the query statement. 

6. 10 INDICATOR  FUNCTION   

The Indicator function provides the capability to identify all facilities that have at least one 
‘vulnerability zone’ that includes either a user entered latitude/longitude or a selected LEPC . 
The vulnerability zone is defined as the circle described by a facilities’ latitude and longitude 
(center) and the distance to endpoint (radius) entered for an Off-site Consequence Analysis 
(OCA) scenario. 

The capability to identify the facilities whose vulnerability zone(s)1 include a user entered 
latitude/longitude is provided by the ‘Vulnerability Zones Report’.  The capability to identify 
the facilities whose vulnerability zone(s) include a specific LEPC is provided by the ‘LEPC to 
Facility Indicator Report’. 

The Indicator function may be activated by clicking the button labeled “Indicator Function” on 
the RMP*Review Main Menu or selecting File >Open > Indicator Function from the 
RMP*Review Main Menu’s menu bar.  The RMP*Review Main Menu is shown in Exhibit 6-21. 

Exhibit 6-21: RMP*Review Main Menu 

1There may be up to four ‘vulnerability zones’, one for each type of scenario. 
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Indicator Function User Interface 

Selecting the Indicator function will open the Indicator Function Form shown in Exhibit 6-22. 
This Form contains two check boxes labeled “LEPC to Facility Indicator Report” and 
“Vulnerability Zone Report”.  Click the appropriate check box and click the button labeled 
“GO” to activate the desired report.  Click the button labeled “Cancel” to close the Indicator 
Function Form. 

Exhibit 6-22: Indicator Function Form 

Indicator Function Data 

Preloaded data for the Indicator function are stored in the Facility database (RMPFac.mdb). 
The RMPFac.mdb that was installed with RMP Review Data Version 1.3 included tblFRS_Data 
to support the Vulnerability Zones report.  This table and two other tables that support the 
LEPC to Facility Indicator report (tblLEPC_Data and tlkpLEPC) are included in the installation 
of Risk Management Plan (RMP) Review Data Version 1.4. 

Users may preserve existing state RM P data if they copy these tables to the RMPFac.mdb using 
MS Access 97. If users install RMP Review Data Version 1.4,  they must rerun the 
RMP*ReviewAdmin Import function to refresh tblFacility in the RMPFac.mdb database. 

Vulnerability Zones Report 

The vulnerability zones for this report will be calculated using latitude and longitude values 
provided by the Federal Registry System (FRS), not the latitude and longitude values included 
with the facilities RMP.  This deviation is intended to correct errors in some entered latitude and 
longitude values in a consistent manner. 

The user interface for this function provides two sets of text boxes that allow users to enter the 
latitude and longitude for a position in either degrees, minutes, and seconds or decimal degrees 
as shown in Exhibit 6-2 3. 
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Exhibit 6-23: Vulnerability Zones Report User Interface

 When a user enters data in one unit of measure (i.e., decimal degrees), the software will 
automatically fill the corresponding text box(s) with the correct value in the other unit of 
measurement.  The user interface also contains two command buttons labeled ‘Preview’ and 
‘Cancel’.  Clicking ‘Preview’ will generate the Vulnerability Zones report (shown in Figure 1) 
and clicking ‘Cancel’ will close the user interface. 

The Vulnerability Zones report lists the address of each facility that has at least one distance to 
endpoint value, in an OCA scenario, that is greater than the great circle distance between the 
user entered latitude and longitude and the Facility Registration System (FRS) latitude and 
longitude for the facility. 

In addition to the facility address, four additional columns are provided for each facility.  These 
columns represent the four types of OCA scenarios, and a checkmark is placed in each column 
where the ‘vulnerability zone’ criteria is matched. 

LEPC to Facility Indicator Report 

In addition to creating the Facility to Indicator report, this function allows users to view,  print, 
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and export the detailed RMP report for each facility whose vulnerability zone(s) includes the 
selected LEPC.  The user interface for the Facility to Indicator report is shown in Exhibit 6-24. 

Exhibit 6-24: Facility to LEPC Indicator Report User Interface 

The combo box labeled “STATE:” allows the user to limit the list of LEPC names to a specific 
state. The first choice in the drop down list is ‘All’.  Choosing “All” populates the drop down 
list in the combo box labeled “LEPC:” with all LEPC names in the database.  Before being 
allowed to view the LEPC to Facility Indicator report or viewing RMPs that match the selected 
criteria, the user must select an LEPC Name (or ‘All’) from the LEPC combo box. 

Clicking the button labeled “Print LEPC Report” opens the LEPC to Facility Indicator report 
shown in Figure 2.  If RMPs for the facility have never been imported, the Facility Address 

column will display the facilities’ state as shown in Figure 4. 
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Clicking the button labeled “Print RMPs” opens the Form shown in Exhibit 6-25.  The name of 
the selected LEPC is displayed in the upper portion of the form, above the list box that displays 
the facilities whose vulnerability zone(s) include the LEPC.  It is important to note that only 
those facilities that have RMPs in the database are displayed in this list. 

The “Select All” and “Clear All” buttons select (or unselect) all facilities in the list box.  Users 
may also select one or more facilities in the list box using standard windows techniques. 
Clicking the “Print Selected RMPs” button will send the detailed RMP report for each selected 
facility to the printer.  The RMP that is printed is the most current RMP submitted by the facility. 

Clicking the “Print RMP Sections...” button, while only one facility is selected, opens the “Print 
RMP Sections...” Form shown in Exhibit 6-26.  This is the same Form that is used in 
RMP*Review to select all or individual sections of an RMP to view, print, or export to a foreign 
file format.  The use of this Form is described elsewhere in this User Manual. 

Exhibit 6-25: Print RMPs Form 
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Exhibit 6-26: Print RMP Sections Form 
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APPENDIX A


Navigation Shortcut Keys




NAVIGATION SHORTCUT KEYS 

The following list describes keys used to navigate within RMP*Review System screens and 
sub-screens. 

To navigate between sections of a screen: 

Press To 
F6 Cycle forward through the header, detail section, and footer of 

a screen. For computers attached to Novell servers, this key 
may be disabled. 

Shift+F6 Cycle back through the footer, detail section, and header of a 
screen. 

To navigate in screens with more than one page: 

Press	 To 
Page Down	 Move down one page. At end of record, moves to top of next 

record. 
Page Up	 Move up one page. At top of record, moves to top of previous 

record. 

To switch between modes: 

Press	 To 
F2	 Switch between editing mode (with insertion point displayed) 

and navigation mode 



To navigate between fields and records (in navigation mode): 

Press To 
Tab, Right Arrow, 
or Enter 

Ctrl+Tab 

Move to the next field. NOTE: The Enter key will behave 
differently if you have changed the default using the View 
menu Options command. 
Exit the sub-screen and move to the next field in the master 
screen; if not in a sub-screen, move to the next field. 

Shift+Tab 
Ctrl+Shift+Tab 

Move to the previous field. 
Exit the sub-screen and move to the previous field in the 
Master screen; if not in a sub-screen, move to the previous 
field. 

Ctrl+Shift+Home Move to the first field in the master screen. 
End Move to the last field in the current record. 
Ctrl+End Move to the last field in the last record. 
Home Move to the first field in the current record. 
Ctrl+Home Move to the first field in the first record. 
Ctrl+Page Down 
Ctrl+Page Up 

Move to the current field in the next record. 
Move to the current field in the previous record. 

To navigate in a combo box or list box: 

Press To 
F4 or Alt+Down Arrow Open a combo box or list box. 
Down Arrow Move down one line. 
Page Down Move down one set of values. 
Up Arrow Move up one line. 
Page Up Move up one set of values. 
Tab To exit the box. 

To navigate in a text box: 

Press To 
Down Arrow Move down one line. 
Up Arrow Move up one line. 
End Move to the end of the current line. 
Ctrl+End Move to the end of the last line. 
Home Move to the beginning of the current line. 
Ctrl+Home Move to the beginning of the first line. 
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Acronyms




CPU Central Processing Unit 
CD Compact Disk 

DBA Database Administrator 

EPA Environmental Protection Agency 

HQ Headquarters 
HP Hewlett Packard 
HTML Hypertext Markup Language 

IP Internet Protocol 

LAN Local Area Network 
LEPC Local Emergency Planning Committee 

MB Megabyte 
MS Microsoft 

NAICS North American Industrial Classification System 

OCA Off-Site Consequence Analysis 

PC Personal Computer 

QBE Query By Example 
QBF Query By Form 

RAM Random Access Memory 
RMP Risk Management Plan 

SQL Structured Query Language 
SRMP Systems for Risk Management Plans 
SVGA Super Video Graphics Adapter 

URL Universal Resource Locator 



APPENDIX C


Disk Space Requirements for Individual State Database Files




The following table provides the DBA with the estimated disk space required for 
downloading the individual state RMP dBases from the Web. (These figures were accurate 
at the time they were recorded, however, disk space requirements change as the number of 
RMPs change.) 

State 
Code 

dbf files Zipped dbf files Unzipped Access Database Graphics files 

AK 132 KB 1,560 KB 1,316 KB 0 KB 

AL 1,620 KB 6,286 KB 5,754 KB 912 KB 

AR 570 KB 4,497 KB 4,750 KB 0 KB 

AS 72 KB 1,170 KB 946 KB 0 KB 

AZ 2,797 KB 5,401 KB 2,762 KB 2.46 MB 

CA 4,359 KB 20,501 KB 22,648 KB 1.58 MB 

CO 708 KB 4,785 KB 5,158 KB 104 KB 

CT 1,883 KB 3,876 KB 2,054 KB 1.69 MB 

DC 81 KB 1,223 KB 980 KB 0 KB 

DE 195 KB 1,867 KB 1,734 KB 0 KB 

FL 1,277 KB 10,209 KB 11,376 KB 0 KB 

GA 1,882 KB 7,708 KB 7,028 KB 991 KB 

GU 74 KB 1,177 KB 946 KB 0 KB 

HI 138 KB 1,652 KB 1,378 KB 0 KB 

IA 1,158 KB 12,657 KB 12,830 KB 0 KB 

ID 437 KB 2,483 KB 2,296 KB 188 KB 

IL 4,114 KB 17,157 KB 14,190 KB 2.65 MB 

IN 4,122 KB 12,066 KB 8,546 KB 3.47 MB 

KS 1,682 KB 10,911 KB 8,808 KB 770 KB 

KY 2,514 KB 7,049 KB 5,364 KB 1.89 MB 

LA 2,538 KB 10,828 KB 10,470 KB 1.23 MB 

MA 291 KB 2,559 KB 2,304 KB 0 KB 

MD 368 KB 3,085 KB 3,054 KB 0 KB 



State 
Code 

dbf files Zipped dbf files Unzipped Access Database Graphics files 

ME 166 KB 1,739 KB 1,588 KB 0 KB 

MI 3,596 KB 8,612 KB 5,834 KB 2.94 MB 

MN 1,226 KB 9,105 KB 9,044 KB 305 KB 

MO 1,180 KB 6,623 KB 6,096 KB 500 KB 

MS 496 KB 4,146 KB 4,396 KB 3.94 KB 

MT 262 KB 2,828 KB 2,648 KB 0 KB 

NC 1,260 KB 6,692 KB 6,322 KB 488 KB 

ND 450 KB 5,027 KB 4,610 KB 0 KB 

NE 830 KB 9,100 KB 9,802 KB 0 KB 

NH 119 KB 1,459 KB 1,218 KB 0 KB 

NJ 437 KB 3,220 KB 3,300 KB 0 KB 

NM 308 KB 2,632 KB 2,834 KB 0 KB 

NV 190 KB 1,791 KB 1,698 KB 0 KB 

NY 609 KB 4,743 KB 4,932 KB 0 KB 

OH 4,698 KB 12,942 KB 9,928 KB 3.51 MB 

OK 5,156 KB 11,437 KB 7,824 KB 4.32 MB 

OR 699 KB 3,630 KB 3,378 KB 290 KB 

PA 1,640 KB 8,364 KB 8,376 KB 536 KB 

PR 1,255 KB 4,090 KB 2,886 KB 1.07 MB 

RI 357 KB 1,934 KB 1,424 KB 337 KB 

SC 954 KB 5,420 KB 5,268 KB 413 KB 

SD 1,204 KB 3,765 KB 2,236 KB 1.06 MB 

TN 1,507 KB 5,961 KB 5,242 KB 948 KB 

TX 10,114 KB 33,696 KB 30,970 KB 6.80 MB 

UT 308 KB 2,509 KB 2,552 KB 16.3 KB 

VA 499 KB 3,925 KB 3,874 KB 0 KB 



State 
Code 

dbf files Zipped dbf files Unzipped Access Database Graphics files 

VI 86 KB 1,305 KB 988 KB 0 KB 

VT 98 KB 1,295 KB 1,118 KB 0 KB 

WA 2,168 KB 6,662 KB 5,128 KB 1.56 MB 

WI 810 KB 5,682 KB 5,248 KB 154 KB 

WV 520 KB 3,242 KB 2,908 KB 117 KB 

WY 301 KB 2,832 KB 3,466 KB 0 KB 
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RMP*ReviewAdmin Ranking and Scoring Example
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Appendix D contains three examples that demonstrate how the Ranking and Scoring 
functionality of RMP*ReviewAdmin may be used to assign scores to a collection of RMPs. 
The following table summarizes the three examples that will be created in Sections D.1 ­
D.3 of this appendix: 

Example Data Element Score 

(1) Use the residential population 
within the greatest distance to an 
endpoint for Toxics and 
Flammables Worst Case scenarios. 

2.12, 4.7 Residential population within distance to 
endpoint. 

> 1,000 people
 101 to 1,000 people
 1 to 100 people 

8 
6 
4 

(2) Use four different Accident 
History data elements to create 
scoring criteria. 

6.10.a Known off-site impacts: Deaths. 

6.10.b Known off-site impacts: Hospitalization. 

6.9.b.i On-site impacts: Injuries; Employees or 
contractors. 

6.10.f Known off-site impacts: Property damage 
($). 

10 

8 

6 

4 

(3) Use quantity of regulated 
substance(s) present at the source 
(each regulated substance should 
contribute to the overall score). 

1.17.c.3 Maximum quantity of each regulated 
substance (should be divided by threshold quantity 
for resulting score rounded to the closest integer). 

Maximum 
score = 10 for 
each substance 

Section D.4 will demonstrate how to combine the “scores” to create a “ranking” (definition) 
from the examples in Sections D.1 - D.3 and Section D.5 will demonstrate how to calculate 
ranking and scoring values from the definition. 
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D.1 Example 1 

Example 1 is implemented by scoring the worst case scenarios for toxic chemicals and 
flammable substances. When more than 1,000 people live within the distance to endpoint a 
score of 8 will be added to the aggregate score. If 101 to 1,000 people live within the 
distance to endpoint a score of 6 will be added to the aggregate score (use 100 as 
threshhold). If from 1 to 100 people live within the distance to endpoint a score of 4 will be 
added to the aggregate score (note: score at least 1 person by entering a threshold of zero). 
Since worst case data for each type of substance (toxic and flammable) are located in 
different tables, criteria must be entered in two screens, as illustrated by the following two 
exhibits: 
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D.2 Example 2 

In order to evaluate scores for four different Accident History data elements (i.e., the score 
names) in Example 2, the RMP*Review Admin user must enter the scores on four separate 
screens as though they were each independent criteria, as illustrated in the following four 
exhibits. NOTE: The threshold is entered as “0” in each of the four screens, because 
threshold is not used to delineate between the data elements. 
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D.3  Example 3 

Example 3 illustrates a special case in Ranking and Scoring. When you select Process: 
Chemicals from the Table Name pick list, then Maximum quantity of each regulated 
substance divided by threshold quantity from the Field Name pick list, the 
Threshold/Scores boxes and the Choose method to score multiple records radio buttons will 
be inactivated (dimmed). The score, up to a maximum of 10 for each process chemical 
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reported in the RMP, will be calculated automatically by dividing the reported quantity of 
the process chemical by the regulated threshold for the process chemical. 

D.4 Defining a Ranking Definition 

Once all the “scores” have been created, you may move to the Ranking tab of the Create 
Ranking Criteria Screen to gather the multiple criteria into a ranking definition (plan). 
The following figure illustrates a ranking definition named “Ranking Example” containing 
the scoring criteria created previously. In this example, all the “scores” were included, 
however, different definitions could have been established by selecting different items from 
the Score Name pick list. 
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D.5 Calulating Ranking and Scoring Values 

Once you have selected the scoring criteria you want for a ranking definition, you may 
move to the Calculate tab of the Create Ranking Criteria Screen. 
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Select Ranking Example, then click Calculate Scores; scores will be calculated for the 
selected ranking definition. NOTE: The Ranking Definition names are displayed in a 
multi-select list box. Use the Shift or Control keys to select more than one ranking 
definition. Scores for each selected definition will be calculated when you click the 
Calculate Scores button. 
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United States Environmental Protection Agency Security Notice




UNITED STATES ENVIRONMENTAL PROTECTION AGENCY 
WASHINGTON, D.C. 20460


Mail Code 5401G


OFFICE OF 
SOLID WASTE AND EMERGENCY 

RESPONSE 

November 2000 

SECURITY NOTICE

To Federal, State and Local Officials


Receiving Access to the Risk Management Program’s

Off-site Consequence Analysis Information 


With this notice, the U.S. Environmental Protection Agency (EPA) is providing you with 
access to the off-site consequence analysis (OCA) information you requested.  As you know, 
OCA information is certain forms of data about the potential public health and environmental 
consequences of hypothetical chemical accidents at industrial facilities.  Under EPA regulations 
implementing section 112(r)(7) of the Clean Air Act (CAA), industrial facilities having large 
amounts of certain extremely hazardous substances must prepare and submit Risk Management 
Plans (RMPs).  Covered facilities must report the results of OCAs for worst-case and alternative 
scenario chemical accidents in sections 2 through 5 of their RMPs (“the OCA sections”).  EPA 
has developed an electronic database that includes the information in the OCA sections. You 
have requested from us a copy of the OCA sections of one or more RMPs and/or the related EPA 
database. While you may share with the public the data in those sections and database, it is a 
violation of federal law for you to disclose or distribute to the public the OCA sections 
themselves or the related database, except as authorized by statute or regulation.  

In this notice we briefly describe the federal statute and regulations that govern the 
distribution of the OCA sections of RMPs and the related database. The statute and regulations 
authorize government officials to distribute some or all of that information to each other and to 
the public under specified conditions designed to protect the information from Internet 
dissemination. The statute and regulations also prohibit government officials from distributing 
the information under any other conditions.  Here we outline what you may and may not 
distribute to whom and the criminal penalties for violating the applicable restrictions.  For more 
detailed information, we strongly recommend that you read the Federal Register notice issuing 
and explaining the regulations at 65 FR 48108 (August 4, 2000). 

A. What federal law establishes these restrictions? 

The Chemical Safety Information, Site Security and Fuels Regulatory Relief Act 
(CSISSFRRA), signed into law on August 5, 1999, is the basis for the regulations and restrictions 
described in this notice. CSISSFRRA was enacted to address concerns that Internet posting of a 
large database created from the OCA sections of RMPs would pose law enforcement and 
national security risks.  CAA section 112(r)(7) had required public access to RMPs including the 
OCA sections. CSISSFRRA amended CAA section 112(r)(7) by adding a new subparagraph 



(H). CAA section 112(r)(7)(H)(ii) required the President to conduct assessments of both the 
increased risk of terrorist and other criminal activity that would result from posting OCA 
information on the Internet and the chemical safety benefits of allowing public access to the 
information. It further required the President to issue regulations, based on the assessments, 
governing distribution of OCA information.  For the period the President was given to complete 
these tasks, CSISSFRRA prohibited government officials from distributing OCA information to 
the public. 

On behalf of the President, EPA and the Department of Justice (DOJ) conducted the 
assessments and issued regulations that allow public access to OCA information in ways that are 
designed to minimize the likelihood of chemical accidents, the risk associated with Internet 
posting, and the likelihood of harm to public health and welfare.  The regulations, codified at 40 
CFR Part 1400, also provide for distribution of OCA information to federal, state and local 
officials. In addition, the regulations extend the prohibition in CSISSFRRA against government 
officials and researchers distributing OCA information except as authorized by CSISSFRRA or 
the regulations themselves.  In this notice we refer to the regulations as the “OCA regulations.” 

B.	 What information is subject to the restrictions on distribution? 

CSISSFRRA and the OCA regulations extend the restrictions on distribution only to the 
two classes of information described below: 

1.	 OCA information 

CSISSFRRA and the OCA regulations define “OCA information” as 

o	 the OCA portion (i.e. sections  2 through 5) of RMPs that facilities have 
submitted to EPA under 40 CFR Part 68; and 

o	 any EPA electronic database created from those portions. 

It is important to understand that the definition of OCA information is narrow in scope. 
First, it does not include the Executive Summary portion of RMPs.  Every RMP must contain an 
Executive Summary, which in turn must include at least a brief description of the OCA(s) 
conducted by the facility submitting the RMP.  Since Executive Summaries are not formatted in 
a way that lends itself to creation of a large OCA database that could be posted on the Internet, 
the definition of OCA information excludes them. 

Second, the definition does not include the results of the analysis reported in the OCA 
sections of an RMP or the related database when presented in a different format. CSISSFRRA 
states that it “does not restrict the dissemination of [OCA] information by any covered person in 
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any manner or form except in the form of a [RMP] or of an electronic data base created by 
[EPA]” (Clean Air Act section 112(r)(7)(H)(xii)(II)) (emphasis added).  Sections 2 through 5 of 
RMPs are sensitive because those sections could be compiled fairly easily into a large OCA 
database that could be posted on the Internet.  EPA’s OCA database is even more sensitive 
because it could easily be posted on the Internet.  Consequently, CSISSFRRA’s prohibitions 
extend to RMP sections 2 through 5 and the related EPA database (i.e. “OCA information”) but 
not to the OCA results reported in those sections or the database. To capture this distinction, the 
OCA regulations created the term “OCA data elements” to refer to the results of OCAs when 
presented in a format different than sections 2 through 5 of an RMP or EPA’s database.  This 
notice uses “OCA data elements” for the same purpose. 

2.	 OCA rankings 

The OCA regulations define OCA rankings as 

o	 any statewide or national ranking of identified facilities derived from 
the OCA portion of RMPs. 

C.	 Who is subject to the restrictions on distribution? 

CSISSFRRA applies its restrictions to “covered persons.”  The OCA regulations use the 
term “government officials” to refer to the largest categories of covered persons.  The three 
categories of covered persons are: 

1. Federal government officials: An officer or employee of the United States or of 
an agent or contractor of the Federal Government. 

2. State or local government officials: An officer or employee of a State or local 
government or of an agent or contractor of a State or local government, or an individual affiliated 
with an entity that has been given, by a State or local government, responsibility for preventing, 
planning for, or responding to accidental releases (for example, a volunteer firefighter or a 
member of a State Emergency Response Commission (SERC) or a Local Emergency Planning 
Committee (LEPC) established under the federal Emergency Planning and Community Right-to-
Know Act), or an officer and employee of an agent or contractor of such an entity. 

3. Covered researcher: A researcher as identified by EPA under the qualified 
researcher provision of CSISSFRRA (CAA section 112(r)(7)(H)(vii)). 

CSISSFRRA itself provides that the distribution restrictions apply “only to covered 
persons” (CAA section 112(r)(7)(H)(xii)(I)).  Accordingly, the OCA regulations apply the 
restrictions only to covered persons.  Members of the public, including private individuals 
and entities, are not prohibited from distributing OCA information or rankings. 
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D. What are the restrictions on distribution? 

Prior to issuance of the OCA regulations, covered persons were prohibited from 
distributing OCA information and rankings to the public in any form (paper or electronic) except 
as authorized by CSISSFRRA.  The only exception to the prohibition was for the OCA sections 
of RMPs that were released to the public “without restriction” by the facilities submitting them. 

CSISSFRRA required that the OCA regulations provide the public with some access to 
OCA information. Specifically, it required the regulations to govern distribution of OCA 
information in a manner that would minimize the likelihood of chemical accidents, the risk 
associated with Internet posting of OCA information, and the likelihood of harm to public health 
and welfare.  At a minimum, the regulations were to allow any member of the public access to 
paper copies of OCA information for a “limited number” number of facilities and with other 
access “as appropriate.”  They were also to provide government officials with access to OCA 
information in accordance with specified geographical restrictions.  The regulations could extend 
the restrictions on distribution of OCA information by government officials as needed to meet 
the statutory test of minimizing the overall risk of chemical releases and to implement the 
specific provisions described above. 

The OCA regulations issued by EPA and DOJ provide the public with limited, controlled 
access to OCA information. To provide that access, the regulations significantly expand the 
authority of government officials at the federal, state and local level to provide public access to 
OCA information under conditions designed to minimize overall risk.  Briefly, the regulations 
require the federal government to allow any member of the public to obtain access to OCA 
information for up to 10 facilities per calendar month located anywhere in the country, without 
geographical restrictions.  Access will be provided at 50 or more federal reading rooms 
distributed across the United States and its territories. Reading room access will begin by 
December 31, 2000. The regulations also require EPA to provide the public with Internet access 
to the OCA data elements that pose the least serious criminal risk by December 31, 2000.  In 
addition, to help members of the public learn about chemical hazards in their communities, the 
regulations directed EPA to establish a vulnerable zone indicator system over the Internet or by 
phone or mail which has been available since October 5, 2000. Further, the rule authorizes and 
encourages state and local agencies involved in chemical emergency planning, prevention, or 
response to provide the public with read-only access to OCA information for local facilities.  For 
further information about these rule provisions, please see 65 FR 48108 (August 4, 2000). 

The following section of this notice describes what OCA information the regulations 
authorize different categories of government officials to provide to other categories of 
government officials and to the public.  It does not, however, attempt to describe the 
requirements that may apply to providing access.  For instance, the regulations require federal 
reading room personnel to ascertain the identity of persons requesting access to OCA information 
before providing them with access.  The OCA regulations and the Federal Register notice issuing 
them should be consulted to learn about the requirements for providing access. 
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With regard to OCA rankings, the rule codifies CSISSFRRA’s prohibition on distribution 
of OCA rankings to the public.  Consequently, as a government official you may develop OCA 
rankings and share them with other government officials, but you may not share them with the 
public. 

E.	 May I share OCA information with other government officials? 

The OCA regulations authorize you to distribute some or all OCA information to other 
government officials based on the category of government official to which you belong and to 
which your intended recipient belongs, as described below.  Any time you distribute OCA 
information to another government official, you should send a copy of this notice with the 
materials so that the recipient will be informed of the applicable restrictions. 

1.	 A Federal government official may 

C	 distribute to another Federal government official, for that person’s official use, 
any or all OCA information; 

C	 distribute to a State or local government official, for that person’s official use, 
OCA information only for the facilities located in that person’s State. 

In addition, a Federal government official who works for EPA may 

C	 distribute to a State or local government official, at that person’s request and for 
that person’s official use, OCA information for facilities located in States other 
than that person’s State. 

2.	 A State or local government official may: 

C	 distribute OCA information for only the facilities located in his or her State to a 
Federal government official for that person’s official use; 

C	 distribute OCA information for only the facilities located in his or her State to a 
State or local government official in his or her State for that person’s official use; 
and 

C	 distribute OCA information for only the facilities located in his or her State to a 
State or local government official in a State contiguous to his or her State for that 
person’s official use. 

F.	 May I share OCA information with the public? 

The OCA regulations authorize you to provide the public with read-only access to some 
OCA information depending on the category of government official to which you belong and, in 
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some cases, depending on where the member of the public lives or works, as described below. 

1. A Federal government official who helps operate a federal reading room may 
provide any member of the public with read-only access to OCA information for 

C up to 10 stationary sources located anywhere in the country, without geographical 
restriction, in a calendar month; and 

C stationary sources located in the jurisdiction of the LEPC where the person lives 
or works and for any other stationary source that has a vulnerable zone that 
extends into that LEPC’s jurisdiction. 

2. A State government official may, to the extent authorized by the State’s SERC or a 
related state government agency, provide any member of the public with read-only access to 
OCA information for 

C	 stationary sources located in the jurisdiction of the LEPC where the person lives 
or works and for any other stationary source that has a vulnerable zone that 
extends into that LEPC’s jurisdiction. 

3. A local government official may, to the extent authorized by the relevant LEPC or a 
related local government agency, provide any member of the public with read-only access to 
OCA information for 

C	 stationary sources located in the jurisdiction of the LEPC and for any other 
stationary source that has a vulnearble zone that extends into that LEPC’s 
jurisdiction. 

G.	 Are there any exceptions to the distribution restrictions? 

Yes. The restrictions described above do not apply to the OCA sections of RMPs for 
facilities that have released those sections of their RMPs to the public without restriction (see 
CAA section 112(r)(7)(H)(v)(III)(aa)).   CSISSFRRA requires any facility that releases the OCA 
sections of its RMP to the public without restriction to notify EPA that it has done so (CAA 
section 112(r)(7)(H)(v)(III)(bb)).  CSISSFRRA further requires EPA to make publicly available a 
list of facilities that have so notified EPA.  EPA has posted that list on its RMP*Info website at 
http://www.epa.gov/ceppo/tools/rmp-info/oca-pub.htm.  You may also get a copy of the list by 
calling the RMP Reporting Center at (703) 816-4434. 

H. 	 What other OCA-related information may I share with the public? 

As explained above, CSISSFRRA and the OCA regulations restrict the distribution of 
only OCA information and OCA rankings..  You are free to share any other OCA-related 
information with the public. For example, you may provide any member of the public with the 

6


http://www.epa.gov/ceppo/tools/rmp-info/oca-pub.htm


results of the computer-based vulnerable zone indicator that EPA is required to make available. 
You may also share with the public OCA data elements (defined above). 

I. Do these restrictions override the public information laws of my State or locality? 

In general, yes.  However, CSISSFRRA provides that a State that collects under its own 
law information on the off-site consequences of chemical releases is not precluded from making 
that data available to the public (CAA section 112(r)(7)(H)(x)(II)). 

J. What does “official use” mean? 

“Official use” is defined by CSISSFRRA to mean “an action of a Federal, State, or local 
government agency or an entity [such as a SERC, LEPC or volunteer fire department] intended to 
carry out a function relevant to preventing, planning for, or responding to accidental releases” 
(CAA section 112(r)(7)(H)(i)(II)). 

Following are examples of what would constitute “official use” of OCA information (i.e. 
the OCA sections of RMPs and EPA’s database created from those sections) by a government 
official: 

C Analyzing the OCA information for facilities in your jurisdiction for purposes of 
emergency planning, prevention or response. 

C Communicating the results of the analysis described above to other government 
officials and/or the public as part of emergency planning, prevention or response 
efforts, so long as you do not distribute the OCA information itself to the public or 
to other government officials except as authorized by the OCA regulations; for 
example, you may communicate OCA data elements to the public and any other 
government official. 

C Analyzing the OCA information for facilities in your jurisdiction to determine 
which facilities present the greatest risk to the public in case of a accidental 
release, so that you can focus your emergency planning, prevention or response 
efforts accordingly. 

C Communicating the results of the analysis described above to other government 
officials and/or the public, so long as the results do not rank facilities either 
nationally or statewide, or, if the results do take such a form, so long as they are 
communicated only to other government officials. 

C Comparing the OCA information for facilities in your jurisdiction with the OCA 
information for facilities in other jurisdictions, to gain insight into whether the 
facilities in your jurisdiction have appropriate accident prevention programs. 
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C Communicating the results of the comparison described above with other 
government officials and/or the public, so long as you do not distribute the OCA 
information itself to the public or to other government officials except as 
authorized by the OCA regulations. 

C Considering the OCA information for facilities in your jurisdiction in making 
decisions about zoning or land use planning. 

C Providing the public and other government officials with access to OCA 
information in accordance with the OCA regulations. 

C Accessing OCA information as needed to operate the vulnerable zone indicator 
system. 

Following are examples of what would not constitute “official use” of OCA information 
by a covered person: 

C	 Distributing (in paper or electronic form) OCA information to the public as part of 
an information or education campaign except to the extent authorized by the OCA 
regulations. 

C	 Disclosing or distributing OCA information to a private party in a court suit 
involving a chemical accident at a facility, except where the private party is the 
owner or operator of the facility.  (Note, however, that disclosure to judges and 
court employees would be permissible since they are government officials). 

K.	 What are the penalties for violating the restrictions? 

A covered person who willfully violates a restriction of CSISSFRRA or the OCA 
regulations is subject to a fine for an infraction under title 18 of the United States Code, section 
3571. For individuals, the fine is not more than $5,000; for organizations, the fine is not more 
than $10,000. If unauthorized disclosure relates to more than one facility, disclosure of each 
facility’s OCA information is a separate offense.   The total of all criminal penalties that may be 
imposed on a single person or organization cannot exceed $1,000,000 for violations committed 
during any one calendar year.  A government official who violates the provisions of the OCA 
regulations is also subject to civil liability under the provisions of the CAA section 113. 

L.	 Where can I get more information about the restrictions? 

A set of questions and answers concerning CSISSFRRA and the OCA regulations is 
available at http://www.epa.gov/ceppo/q&a.html.  EPA, in consultation with other federal 
agencies, will continue to add new questions and answers as the need arises. 
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Section 1 of an RMP contains the Registration Information for the submitting facility. 
This data is stored in tblS1Facilities of the RMP database (RMPData.mdb.) In 
RMP*Review, data such as Receipt Date and Submission Type entered at the Reporting 
Center are also stored in this record. Associated with tblS1Facilities are four lookup tables; 
tlkpCountyFIPSCodes, tlkpLatLongMethods, tlkpLatLongDescriptions, and 
tlkpFIPSCodes. No relationships are set in the database between tblS1Facilities and these 
lookup tables. 

NOTE: All of the following MS Access table and field names are displayed in the Advanced 
QBE window. This information is also useful for creating compound criteria in a QBF 
field. 

Figure 1. tblS1Facilities and its Lookup Tables 



May 2000 

Figure 2 shows the relationships between tblS1Facilities and the Executive Summary, 
Accident History, Emergency Response Plans, and RMP Error tables. Note, there is no 
direct relationship between tblS1Facilities and tblRMPTrack since a tracking record may 
contain data about an RMP that was not entered into the database. 

Figure 2. tblS1Facilities Relationships 
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Figure 3 shows the relationship between tblS1Facilities and covered processes. Covered 
processes have the relationships shown in Figure 3 to Process NAICS codes and Process 
Chemicals. 

Figure 3. RMP Covered Processes 
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Figure 4 shows relationships between tblS1Facilities and the tables containing OCA 
records. 

Figure 4. Relationships between tblS1Facilities and OCA records. 
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Figure 5 shows the lookup tables associated with tblS2ToxicsWorstCase. 

Figure 5. Lookup tables associated with tblS2ToxicsWorstCase 

Figure 6 shows the lookup tables associated with tblS3ToxicsAltReleases. 

Figure 6. Lookup tables associated with tblS3ToxicsAltReleases 

There are no lookup tables associated with the Flammables Worst Case and Alternative 
Releases scenarios. 
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Figure 7 shows Prevention Program Relationships. Program Level 2 and Program Level 3

Prevention programs have similar relationship diagrams.


Figure 7. Prevention Program Relationships 
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QBF Examples
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Example 1: Find RMPs for facilities with an OSHA Star or Merit ranking.


At Section 1.13 of the RMP QBF form:


CC Click OSHA Star or Merit Ranking. 

CC Click OK to run query. 


Example 2: Select all RMPs for facilities in zip code 63115.


At Section 1.5 of the RMP QBF form:


CC Enter 63115 (for St. Louis, MO).

CC Click OK to run query.


Example 3: Enter multiple criteria


At Section 1.5 of the RMP QBF form, enter: 


CC =’33009' or =’34221'

CC Click OK to run query. 

Example 4: Without resetting the query from Example 3, select all RMPs for a facility

name within the selected zip codes.


At Section 1.1 of the RMP QBF form:


CC Enter a facility name.

CC Click OK to run query.


Example 5: Find all facilities with accident history records.


At the List of Facilities Screen:


CC Click the View RMP Detail button. 
CC Click Section 6 (at the RMP Registration Information Screen). 
CC Click the Query (QBF) button (a blank Section 6 form displays). 
CC Click on the No reportable accidents in the last five years check box twice 

(Check box goes from null state, to checked, to clear - meaning find all reportable 
accidents that occurred in the last five years). 

CC Click OK to run query. 

Example 6:  Find RMPs where there were reportable accidents on 05/12/1999. 
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CC Click QBF Reset from any RMP detail form.

CC Click Section 6 (for Accident History section).

CC Right click (for short cut menu), then click Remove Filter 


(record count now includes all records). 
CC Click on the No reportable accidents in the last five years check box twice 

(Check box goes from null state, to checked, to clear - meaning find all reportable 
accidents that occurred in the last five years). 

CC Enter “05/12/1999” in the Date of Accident field. 
CC Click OK to run query. 

Example 7:  Find all RMPs that fall between two dates (inclusive). 

CC Click QBF Reset from any RMP detail form.

CC Click Section 6 (for Accident History section).

CC Right click (for short cut menu), then click Remove Filter 


(record count now includes all records). 
CC Click Query (QBF) button. 
CC Edit Date of Accident field: 

-	 <Shift+F2> (not needed, but included as an example for Zoom). 
-	 Enter “BETWEEN #01/01/1990# AND #12/31/1998#” (example of a date 

span). 
C	C Click OK to run query 

(need “#” before and after dates in BETWEEN … AND construct). 

Example 8:  Find all RMPs with a date prior to, or after, a given date. 

C	C Similar steps as in Example 7, except enter “<12/31/1998” or “>01/01/1990” 
in Date of Accident field. 
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APPENDIX H


QBE Examples
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Example 1: List accident history of chemicals released in pounds by Facility ID. 

C	C Click Table pick list button, 
-	 Select Accident History from pop-up list, 
- Double click FacilityID in the AVAILABLE list. 

CC Click Table pick list button, 
-	 Select Accident History: Chemicals, then 
- Double click Chemical ID and Quantity Released. 

CC Click the Table pick list button, 
-	 Select Lookup: Process Chemicals, then 
-	 Double click Chemical Name. 

C	C Click View; a list displays with columns for those items displayed in the Selected 
block. 

Example 2: List all RMPs that process ammonia (start from where Example 1 left off). 

CC Click on Chemical Name in Selected block.

CC Click on Where button.

CC Press <Shift + F2> (to invoke Zoom).

CC Replace “=” with <like “ammonia*” >

CC Click View to display the list of RMPs that process ammonia
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Example 3: Write a Custom SQL Query (start from where Example 2 left off). 

CC Click SQL button.

CC Press <Ctrl + c> to copy the generated SQL for Example 2 to the Windows


clipboard. 
CC Close the SQL window. 
CC Click on the Write a Custom SQL Query tab. 
CC Click New, then enter a query name (e.g., “SQL Example” ). 
CC Press <Ctrl + v> to paste the SQL from the Windows clipboard. 
CC Click View to display same results as in Example 2. 
CC If you know how to use SQL, you can modify the query. 

Example 4: Use county FIPS code in a query. 

CC Click New to start a new QBE. 
CC At the Advanced Query by Example (QBE) Screen, click the Design a Query by 

Example tab. 
CC Select the following fields from the Registration Information table: 

EPAFacilityID FacilityCity 
FacilityName FacilityState 
FacilityStr1 FacilityZipCode 

CC Select the County_Name field from the Lookup: County FIPS codes table: 
CC Order by EPAFacilityID, then click View (note that there will be duplicate 

EPAFacilityID’s where there are multiple RMPs for facilities). 
CC Click the SQL button (note SELECT ALL). 
CC Click the Distinct button in Record Selection block. 
CC Click View again (note that the duplicates are now gone). 


